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SECTION 1: Getting Started 

 

In this section you will learn how to: 

 Identify and understand some database terminology 

 Use the new features of Access 

 Use the Getting Started window 

 Create a database from scratch 

 Create a database using one of the many templates 

 Identify some database security terminology and concepts 

 Understand and use the Trust Center 

 Understand how digital signatures work 

 Apply a password to a database file 

 Use the Access help page 

 Use the features of Office Online 
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Lesson 1.1: Starting Out 

Welcome to the Microsoft Access Foundation courseware! Microsoft Access is a 

database management program contained in the Microsoft Office suite. Access has 

been rebuilt from the ground up. If you are familiar with databases or have used other 

versions of Access in the past, Access features an all-new interface, drag-and-drop 

functionality, modern styling, and a large variety of enhanced connectivity, features, and 

security. 

 

However, if you have avoided using Access or other database management program in 

the past because you felt they might have been too difficult, or if you have never used a 

database program before, fear not! Access has an extremely intuitive interface and many 

customizable templates that will suit all of your requirements. 

 

Microsoft has made a big effort with the Office 2007 package (and, of course, Access) to 

get you ready and working as fast as possible. So, without further ado, let’s examine the 

interface and get started with the essentials of Access. 

What is Microsoft Access? 

The primary function of Microsoft Office Access is an information management 

program. Information is stored in separate lists called tables, and information in one 

table may relate to information in one or more other tables. These groups of 

information, when considered together as a whole, become a database. 

 

Access is designed to use the data in these databases to extract the information relevant 

to your situation. Access can also generate reports (such as quarterly sales by each 

employee) based on the data contained in the database. The Office 2007 package also 

features a lot of interconnectivity between the various programs, including a newly 

designed SharePoint service that lets users in your organization connect and share 

information using a special data center via the Internet. 

What’s New in Access? 

If you are familiar with previous versions of Access, there are a large number of new 

features and a completely new interface in Access. If you have never used Access before, 

don’t worry – you will quickly become very familiar with these commands as time goes 

on! 
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New Interface Design  Commands hidden in four different menu layers are a thing 

of the past with Access.). Commands are now organized using 

a new action tab scheme. Under each tab are the commands 

relevant to the action described on the tab. This command 

set is referred to as the ‘ribbon.’ Finally, Access features 

contextual tabs showing data that is relevant only to the 

current object you are working on. We will explore the new 

interface in more detail later. 

 

 
 

New Template 
Categories 

Access features eleven new templates, each with their own 

defined tables, forms, reports, queries, and relationships. They 

are designed to let you start working right away, but are also 

completely customizable.  

More Intuitive Sorting 
and Filtering 

Access lets you pick from several predefined sorting methods 

with just a couple of clicks. Access also features a contextual 

quick sorting method using plain language. For example, if 

you have a column of numbers, Access can sort them 

Smallest to Largest. If you have a column of dates, Access can 

sort them from Oldest to Newest.  

New Layout View When working with forms and reports, Access features an in-

between view called Layout View. It allows you to see a live 

form or report with real data in it, but also lets you adjust the 

position of certain elements in your form or report on the fly. 

You can also define ‘mini layouts’ that allow you to move 

several controls as a group. Access still features the more in-

depth Design view, used to fine tune every aspect of a 

control.  
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Enhanced Tooltips When you hover your mouse above certain command icons, 

Access lists the command name, a short description of the 

command, and an example (if applicable). (Tooltips in 

previous Office programs listed only the command name.) 

Automatic Calendar When entering information into a Date field, a small icon will 

appear allowing you to choose a date from a small calendar. 

This eliminates the need to enter a date as 03/22/2007 – just 

open the calendar and pick the date!  

Rich Text in Memo 
Fields 

If a table makes use of a memo field, data can now be stored 

as something other than plain text. Using an HTML-based 

text format, Access lets you automatically add colors, sizes, 

and formatting to the text in a memo field.  

Quickly Create New 
Objects using the 
Insert Tab 

In previous versions of Access, you had to move and minimize 

windows to find the Database window, pick the category of 

database object, and then choose to create a new object. 

With the Insert tab and ribbon, you can create a form based 

on a table with only two clicks (versus as many as a dozen 

clicks in the past). 

 

If you need a new table at any point, simply click Table on the 

Insert tab and start entering data. Access even lets you paste 

data directly from a Microsoft Excel spreadsheet. Data types 

and formatting will be found and preserved automatically. 

Total Row in 
Datasheet View 

Every table in Datasheet view features an automatic Total 

Row at the bottom. You can find the sum, count, average, 

maximum, minimum, standard deviation, or variance using 

the Total Row.  

Field Templates In the past, it was potentially a long and tedious task to 

mould a number data type into a usable field for your 

organization. Now, you can simply click and drag a 

predefined field from a list right into your table at any point. 

Field List Task Pane When creating a query in previous versions of Access, each 

table had to be inserted into Design view in order to use 
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various fields. Now, all fields in all tables are visible in a list. 

Just drag and drop the ones you need. 

Split Forms A Split Form is new to Access; it combines Datasheet and 

Form view together as one. The Datasheet view can be placed 

on the top, bottom, left, or right side of the Form. 

Multivalued Fields A single field can contain multiple values in Access. Imagine 

you have a product that falls into a few different categories. 

In previous versions of Access and other database 

management programs, this would have required a many-to-

many relationship to be defined. Access handles this 

complicated background relationship with only an extra click 

when designing a field.  

Attachment Data 
Type 

If you want to e-mail a document to a coworker or some 

pictures to family members, the files would be sent as an 

attachment to the e-mail. Access features a similar 

attachment data type that can hold documents, charts, sound 

files, binary files, or any other type of file. Attachments are 

also automatically compressed when necessary to reduce the 

overall size of the database file. 

Alternating 
Background Color 

Datasheet view, reports, and long forms now feature the 

ability to alternate the background colors of each row. Long 

lists of data become much easier to read! 

Navigation Pane The Navigation Pane is an ever-present feature on the left 

side of the Access window. It contains a listing of all objects 

currently contained in the database. The Navigation Pane can 

also be collapsed to make more room in the window. 

Embedded Macros Though macros go beyond the scope of this manual, macros 

in Access are stored inside a database object instead of being 

a separate object. This makes these macros much safer to 

use. 

Newly Designed Help Office 2007 makes wide use of Office Online, a resource on 

the Internet to find help on a certain topic. Access also has 
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different help levels; if you are an end-user rather than a 

developer who makes database code, you can tailor the help 

file to search only the more basic topics. 

Increased and 
Enhanced 
Connectivity 

One of the goals of Office 2007 was to create a centralized 

location where members of your organization can meet and 

share data over the Internet. Though many of these features 

are more advanced topics of Access not covered in this 

manual, Access features a huge variety of SharePoint services. 

Access lets you: 

 Collect data from Microsoft Outlook 

 Store and retrieve data on a SharePoint server 

 Integrate with SharePoint Workflow services 

 Retrieve data from linked SharePoint lists 

 Store a SharePoint list offline for use away from your 

organization 

 Create and save import or export operations if you 

perform the same online task multiple times 

Export Data to PDF or 
XPS 

You can export a form, report, or datasheet as a PDF 

(Portable Document Format) or XPS (XML Paper Specification) 

to easily print, post, and e-mail regardless of the computer 

platform your intended recipient(s) are using. 

New Report View Report view allows you to browse your report without having 

to print or preview it. You can also sort and filter records on 

the fly.  

Enhanced Group, 
Sort, and Total 
Feature 

You can apply new grouping and sorting levels much easier 

with Access. Grouping is done following a natural sentence 

structure; you simply fill in the blanks along the way. 

Additional Security 
Features 

Though many of the security features go beyond the scope of 

this manual, Access (and indeed the entire Office 2007 suite) 

features a number of security enhancements and SharePoint 

services. This functionality includes: 

 Enhanced security by disabling macros and code only 

until needed 

 Revision tracking to see who modified what and when 

 Permission setting to restrict data modification 
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 Restore deleted data from the SharePoint Recycle Bin 

in case of accidental deletion 

 Open forms and reports using SharePoint even if 

Access is not open on your computer 

 Keep track of changes made to memo fields 
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Basic Terminology 

Let’s take a look at the terminology used in database-speak, starting with the basics. 

Consider the following diagram: 

 

 
 

Let’s look at each piece of the database. 

 

Field A field is the smallest piece of a database; that is, one 

specific piece of information like a number, a word, a date, a 

picture, or a reference for some other piece of data. Each 

column you see in the diagram would all be the same data 

type; that is, one column of data would all be numbers. 

Record A record is a collection of one or more fields together in a 

row. (In a real database, you would not count the word 

‘Record’ as depicted in the diagram – this is just to help 

visualize the concept.)  

Table A table is comprised of one or more records. Each table also 

has a unique name.  

Database A database is comprised of one or more tables. Each 

database is also given a unique name.  
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Form A form is a tool that is used to easily and accurately enter 

data into a table. A form presents one record of a database 

at a time to a user, or allows a user to enter data into the 

database one record at a time.  

Query A query is just like a question you ask the database. There 

are two types of queries: select and action. A select query 

will extract and display data based on criteria you provide. 

An action query will find all data relevant to your query and 

perform some sort of operation on it. A query can be 

performed on one or more tables in a database.  

Report A report presents the data found by a query. A report can be 

formatted to show summaries, calculations, charts, and more 

based on the data returned by a query. Access takes the 

report one step further by letting you organize and format a 

report into a sleek, professional document suitable for 

printing, exporting, or e-mailing.  

 

This might seem like a lot to remember, but don’t worry – this terminology will be used 

heavily throughout this manual and soon it will be second nature! 

 

 



   

 

 

www.MicrosoftTraining.net  0207 987 3777 11 
 

Opening Microsoft Access 

To launch Microsoft Access, click Start, All apps, Access 2016.  
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You may have an icon for Access on your desktop; if this is the case, simply double-click 

the icon to launch the program: 

 

 

Interface Overview 

In this section, we will learn about the Access starting screen and the view of a typical 

working database. We will introduce the views piece by piece in this section of the 

lesson. There are a large number of updates to learn about, but with time you will 

wonder how you ever managed without them! 

 

If you have ever used Access before, the welcome screen for Microsoft Access has been 

completely redesigned. However, the layout is much easier to use, especially if you have 

never used Access before: 

 

 
 

Let’s explore the different parts of the Access Getting Started interface: 
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New Blank Database 
 

 

In the center of the window is a link to create a new Blank 

Database. Use this link to make your own database from 

scratch. 

 

 

 

 

File Menu 

 

   

The File menu is available once you have created a blank 

database or opened another database file. Clicking File takes 

you to the back stage view that you see when first opening 

Access.  File management commands are listed on the left-

hand side of the menu, and any recently opened database 

files are listed on the right. You can also modify options of 

Access itself by clicking the Option. 

Quick Access Toolbar 

 

To the immediate right of the Office Menu is the Quick Access 

Toolbar. This toolbar contains quick links to common tasks, 

such as the Save, Print, and Undo (listed left-to-right in the 

diagram). You can also customize the Quick Access toolbar to 

include whatever icons you like. We will explore the Quick 

Access toolbar in the next section of this manual. 

Title Bar 
 

 

The very top of the Access window is the title bar, stating the 

program name, the file name (if a file is open), and (from left 

to right) the Minimize, Maximize, and Close buttons. 

New 
 

Click New to view the Templates window: 
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Access has a number of templates built right into the 

program. To access the different categories of templates, 

simply click a category to see the available template files.  

 

You can also search for online templates. If you are online 

click in the search box to find templates not just from Access 

but for other Office applications such as Excel.  

Recent The right-hand side of the window lists any recently opened 

database files, just like the Office Menu: 

 

 
 

Click one of the database files to open the file. If you want to 

open a database file stored somewhere else on your 

computer or on another network, click the More link and 
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browse to the file you want to open, and then click the Open 

button. 

Status bar 
 

 

Finally, at the very bottom of the Access window is the status 

bar. This bar will give information about the status of Access, 

if any particular lock keys are enabled on your keyboard, 

which view is currently active, and more. 

 

The new interface design of Access makes it easy for novice and expert users alike to get 

working right away. Now that we know a little bit more about the Getting Started page, 

let’s examine the major pieces of the interface that is visible when a file is opened.  
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Consider the following diagram showing an open database: 

 

 
 

In this diagram, we can see the File Menu and Quick Access toolbar present in the upper 

left-hand corner. At the bottom of the diagram is the Status bar, telling us that we are 

currently viewing a table in Datasheet view. Now let’s explore the real power of Access, 

including the use of tabs and the ribbon. 
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Command 
Tabs 

Along the top of the window are the command tabs: 

 

 
 

In the past, the Office package made use of menus that contained a 

listing of commands. At their core, the command tabs are essentially 

the same thing as menus but with a few big changes. For starters, the 

grouping of commands in tabs is much more intuitive. The commands 

listed under each tab are also the only commands that are applicable to 

your current view of the database.  

 

Access takes this one step further with the addition of contextual tabs. 

The tab labeled Table Tools - Datasheet appears only when you have 

selected a table in Datasheet view. This tab will contain even more 

specific commands that can be used on a table being viewed in 

Datasheet view and will only be visible when a table is being viewed in 

Datasheet view. 

Ribbons Consider the Home ribbon tab that is selected in the diagram above. 

Beneath the tab is a listing of all commands that are performed most 

often on the currently selected object, contained in what Microsoft 

refers to as the ‘ribbon’: 

 

 
 

The ribbon was designed to allow access to all functionality of a tab at 

once. Also, the commands in the ribbon are only the commands that 

are available for use at the time.  

Navigation 
Pane 

On the right side of the Access window is the Navigation Pane. It is 

always visible on the left side of the screen, but can be expanded ( ) or 

shrunk ( ) by clicking the double arrows. The Navigation Pane allows 

quick and easy access to any of the database objects.  
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Click the pull-down arrow beside the Navigation Pane title ( ) to show 

a list of all object categories: 

 

 

Object 
Tabs 

In previous versions of Access, any open database object was opened in 

its own window and designed to ‘float’ inside the Access Screen. When 

several database objects were open at once, it was difficult to navigate 

through all of the windows easily. Access has solved that problem by 

using tabs: 

 

 
 

Simply click any of the tabs visible on the top to show the database 

object. Opening many database objects will create left and right facing 

arrows (  and ); click on the arrow to scroll that direction through 

the open database objects. If you want to close an object you are no 

longer using, click the Close button ( ) located beside the tabs. 
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Help 
Button 
 

 

The Help button, located to the right of the title bar, launches the 

Access help screen: 

 
 

 
 

Click a topic to view help about that particular subject.  

Tell Me New to Office 2016 is the Tell Me box.  This allows you to type a 

question and the feature doe it’s best to show how to do it! 
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Closing Microsoft Access 

When you have finished using Access, click either Office Menu  Exit Access or click the 

program’s close button ( ) in the upper-right hand side of the Access window. If you 

have any unsaved work still open, Access will allow you to save any changes you have 

made before the program shuts down.  



   

 

 

www.MicrosoftTraining.net  0207 987 3777 21 
 

Lesson 1.2: Using the Getting Started Window 

The Getting Started window appears every time you open Access without directly 

opening a file, or after you close an opened database without actually closing Access. 

Before you have your own established database(s) you can work on, you will likely visit 

this page every time you want to create a new database or check out the latest 

information about Access using Microsoft Office Online. 

Overview of the Window 

 

 
 

The Getting Started window is divided into three parts: 

 

Template Categories Choose the category of template you want to use for your 

database. 

New Database and 
Office Online/ 
Template Type 

The default display of the Getting Started window is a link to 

create a New Blank Database and the Microsoft Office 

Online start page. 

If you have selected a template category you can choose the 

specific template you want to use. 
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Open Recent Database Any database files you have recently opened will be listed on 

the left side of the window, simply click a file name to open 

it. 

Navigating Through the Window 

Navigation through the Getting Started window is easy – just point and click! Using 

Microsoft Online Templates lets you read up on the latest updates to Access, provides 

some tips and tricks about using the program, and lets you download new templates to 

try. You can download any of the templates available on the top portion of the Office 

Online window: 

 

 
 

Simply double-click the database template you would like to download. The right 

portion of the Access window will change to accommodate extra details about the 

template: 
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You can give the template a new name if you wish by typing it into the File Name text 

box and then click Download. Once the file successfully downloads, the Access Help 

window will appear giving you some information about the template as well as the 

ability to rate the template: 

 

 

Close the Access Help window to begin working with the template. 

 

The other links listed in the Microsoft Office Online section of the Getting Started 

window are hyperlinks that will start your default browser and direct you to the 

Microsoft Office Online web site, which is filled with new information, product updates, 

more tutorials, and a wealth of other resources. 

Creating a Database from a Template 

If you are just starting out with Access, or if you have a specific application in mind for a 

database, you can make use of the templates already provided in Access. The templates 

are fully functional tables, reports, queries, and forms that are all related and ready to go 

– all you have to do is add the data! 

 

To use a template, first choose a category in the left side of the window. For our 

purposes, let’s start off with something basic. Access contains a straightforward Contact 

database under the Personal category. Choose Personal from the categories and then 

double-click the Contacts database to prepare to open it: 

 

 

 

Details about the template will be shown on the right-hand side of the screen, click the 

Download button to download it from Office Online and open it. When the template 

opens, close the welcome window that appears by clicking Get Started. 
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The template automatically opens the Contact List form which allows you to enter your 

own contacts one by one into the database. That’s all there is to creating a database 

from a template! All of the objects are already established; all that is required now is for 

you to enter your data. 

 

 

 



   

 

 

www.MicrosoftTraining.net  0207 987 3777 25 
 

Creating a Blank Database 

Most of the time, the templates provided in Access will be sufficient to use as a base to 

get started. However, if you prefer to construct your database from the ground up, 

doing so is easy with only a few clicks. 

 

From the Getting Started page, click Blank Database under the New Blank Database 

heading: 

 

 
 

On the right-hand side of the screen, give the new database a name by typing it into the 

File Name box. If you want to create the database in a specific location, click the small 

folder icon ( ) to the right of the text box. The new file path you select will be shown 

underneath the File Name text box; Access will by default use the Documents folder: 

 

 
 



 

 

 

 

26 0207 987 3777  www.MicrosoftTraining.net 

 

 

Finally, click the Create button. The new empty database will open with a single empty 

table contained inside: 

 

 
 

Now you know how easy it is to get started with a new database using Access. Later in 

this manual we will explore the usage of the different objects contained inside, as well as 

how to properly enter data into a database, or more properly, populate a database. 
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Lesson 1.3: The Trust Center 

The terms computer security, identity theft, and privacy are being used more and more 

all the time. There are a few bad apples out there that like to create viruses and spyware 

for the purpose of disrupting day-to-day business. The Microsoft Windows family of 

operating systems, as well as a number of third-party developers, work hard every day 

to keep your private and sensitive data safe. So does the Office suite. 

 

In this lesson we will explore some of the measures taken by Access to keep your 

computer and yourself from being a victim of an attack or being disrupted while you 

work. 

Warnings You May See when Opening a Database 

 

If you recall the last Step-By-Step exercise, we encountered a warning stating that 

Access has prevented a file from being opened because of the security settings that 

have been enabled on your computer: 

 

 

 

You might also run into other warnings that state Access cannot perform a certain 

action because a non-standard operation was encountered or some part of the 

database file seems to be missing. It is possible that the following warning might appear 

not because a problem was detected, but because a certain section of the database 

might not be fully constructed: 

 

 

Don’t panic! These warnings are designed to protect you, not scare you. Should you 

encounter messages like the ones above, think why it may have occurred. If you 

received the file from someone else, tell them you have encountered a problem before 

opening the file. If you are unsure about the file, contact your organization’s IT 

department for help; they may be able to diagnose your problem and provide a 

solution. It may even be that your security settings are a bit too high for this application 

(which is not always a bad thing). We will discuss what to do in situations like this in this 

lesson. 
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Enabling Content 

If you are sure the file you are opening is safe, or you trust the person it came from, 

simply click the Enable Content button in the bar that appears under the ribbon: 

 

 
 

Doing so will show the Trust In Office dialogue box: 
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In the picture above, Access gave you a warning because it could not identify who made 

the file. This does not necessarily mean that it came from an untrustworthy source; 

perhaps whoever made the file did not bother to apply a digital signature (described in 

the next section) or security certificate. If you are sure the content is safe, simply click 

the Enable this content radio button and then click OK. The file will then open normally. 

 

 

About Digital Signatures 

Digital signatures serve the same purpose as a written signature or an embossed 

certificate: they identify who someone or what something is, and no two individual 

signatures are exactly the same. The same is true with digital signatures. Though the 

topic of signature application is a bit beyond the scope of this manual, the concept is 

fairly simple. 

 

If you are part of a corporate network that sends sensitive trade secrets via electronic 

means, you can apply digital signatures to the files that are created. If you use Access to 

organize supplier information, you can safely send information to another individual in 

your organization. Their computer will hold what is called a digital certificate which is 

designed to ‘decode’ your signature. If your signature decodes properly, no problem – 

the other user will then make use of the supplier information. However if your signature 

does not decode properly, the other user can choose to block content from you (or 

perhaps someone masquerading as you!). 

 

You can view and modify different aspects of Access’ security via the Microsoft Office 

Access Trust Center (described later in this lesson). 

About Trusted Locations 

Imagine you are an employee of a large company and you send and receive files every 

day. Access has been warning you that some files may contain a possible security threat 

because the sender could not be verified. However, you know the sender and know that 

they can be trusted. Therefore, instead of being warned every time you try to open a file 

from them (which can quickly become annoying), you can tell Access that files from a 

certain location can always be trusted. 

 

Trusted locations can include any location on your computer including shared folders, 

any other computer on your network, a server on your network, or some external data 

source across town or across the world! 
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Opening the Trust Center 

All of the security features we have mentioned thus far are accessible through the Trust 

Center. Let’s quickly explore the different sections and options available in each. To 

open the Trust Center, click File  Options. 

 

 

 

 

Down the left-hand side of the Access options window is the link to Trust Center. Click 

the link, and then click the Trust Center Settings button: 
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The Trust Center window will then appear, giving you six different categories of settings: 

 

 

 
 

Trusted Publishers This pane will show you the security certificates of different 

individuals or organizations you trust. 

Trusted Locations This pane allows you to add, edit, or modify different 

locations that contain content you can trust. 

Add-ins Add-ins are third party programs or code that are designed 

to perform a specific task to your database. Add-ins have the 

potential to cause a lot of trouble and ruin the functionality 

of a database (such as deleting all of the data) if they contain 

malicious code. This pane allows you to modify how Access 

will use any add-ins. 
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(If you are familiar with a third party plug-in for a web 

browsing program, such as Adobe Acrobat Reader, the 

principle is essentially the same.) 

Macro Settings Macros are a group of commands that can be executed all at 

once in order to perform some action on your database. But 

because macros can be constructed with special database 

code, they too can cause undesirable effects if they are from 

a bad source. Use this option to modify macro security 

settings. 

Message Bar The Message Bar is set by default to prompt you before 

opening potentially unsafe content. You can turn the 

Message Bar on or off using this pane. 

Privacy Options Access (and other programs in the Office suite) can 

automatically download new content for you, show featured 

links on Office Online, and provides background access to 

help diagnose and fix problems. If you would prefer to not 

see this content, you can modify settings in this pane to 

disable the content. 

 

You also have the ability to translate certain files based on 

the languages installed with your operating system, and 

retrieve reference and research material on the Internet via 

the Privacy Options pane. 

Assigning a Password to your Database 

If you would rather not bother with more advanced security features but still want to 

have some protection, you can assign a password to encrypt the database. To set a 

password, a file must first be opened for exclusive use. To do so, close any open 

databases and then click File Menu  Open: 
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Browse to the database file you wish to open. Instead of clicking Open, click the small 

pull-down arrow attached to the Open button and click Open Exclusive: 

 

 
 

Then, open the database file you wish to protect. Click the File menu, and then click 

Encrypt with Password: 
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When the Set Database Password dialogue box appears, type the password you want to 

use in the Password field, then type it again in the Verify field: 

 

 
 

 

 

 

Once a password is committed to a database file, you must enter the password before 

Access will open it: 

 

 
 

Should you need to remove the password, click the Database tools tab again and click 

Remove Database Password and Encryption: 

 

 

 

Then, enter the password a final time to confirm the removal of the password. 
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Lesson 1.4: Getting Help 

When all else fails, you can always ask for help. All programs make extensive use of the 

Office Online functionality if an Internet connection is available at the time. If your 

computer does not have access to the internet, no need to worry – Access’ offline help 

file is essentially the same, only with no updates to the files nor any tips and tricks to 

help improve your working style.  

 

Help is available at any time in Access, so let’s explore how to make use of the help file.  

Opening the Help Screen 

 

Help is available at any time by clicking the help button ( ) or by pressing the F1 key 

on your keyboard. The Access help file will appear in a new dialogue box that is 

independent of other objects in the Access screen. 

Overview of the Help Screen 

 

The Help Screen in Access is similar in design to a web browsing program. It contains 

navigation buttons to browse through the different help pages, a search bar that lets 

you browse for a specific keyword or phrase, and a viewing area to see the actual help 

file:  
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Let’s look at each command.  

 

Back  
 

 Go back through the visited help pages. 

Forward  
 

 If you went back too far, click forward to advance 

through your history. 

Home  Will return to the Help welcome page. 

Search  Search for a topic. For example, ‘Keyboard shortcuts 

for Access’. 

 

 

The left side of the search bar is a text field where you can enter a keyword or phrase 

about your search topic. The right-hand side of the search bar includes a pull-down 

menu listing the different locations/categories of help the help file can use. We will 

explore how to search for certain help topics later in this lesson. 

 

At the very bottom of the Help window is the status bar. It states which section of help it 

is currently referencing, as well as its connection status to Office Online. 

 

Here are the topics available under Getting Started. 
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Online Help vs. Offline Help 

Though the Office package relies heavily on the Office Online features to extract 

information about a help topic, Access also has a full-featured offline help section. If 

your computer is currently connected to the Internet, Office Online will be automatically 

used to extract the most current help information about your topic.  

 

If your computer is not currently connected to the Internet you still have access to all of 

Access’ help features; simply click the help button or press F1 to open the Access Help 

window: 

 

 

 

The status bar at the bottom of the Help window states that the Offline Access Help is 

currently being used. The icon on the right of the Status bar also shows that the help file 

is being browsed offline. 

 

If your computer is connected to the Internet but you would still rather use the offline 

help file, click the current connection status icon on the right-hand side of the Status bar 

(shown as  in the picture above). A small pop-up menu will appear giving you 

the option to change your connection status: 

 

 
 

When it comes down to finding help about a particular topic, both Online and Offline 

help will be suitable for your own needs. However if you want to have access to new 

templates and the latest information about program \changes, online help is best to 

use, provided you have access to the Internet. 

  



 

 

 

 

38 0207 987 3777  www.MicrosoftTraining.net 

 

 

Section 1: Review Questions 

 

1. Access is designed to… 

A. Store large amounts of data and extract information from it 

B. Present information in a slideshow format about your company 

C. Calculate data using formulas entered into cells 

D. Create professional-looking word processing documents 

 

2. Which service allows you to easily share files with other people in your organization? 

A. Store Services 

B. Sharing Services 

C. Share'n'Store Services 

D. SharePoint Services 

 

3. PDF stands for… 

A. Personal Device for Flotation 

B. Portable Document File 

C. Portable Database File 

D. Portable Document Format 

 

4. Tables are composed of… 

A. Entries 

B. Records 

C. Databases 

D. Relations 

 

5. How many tables are needed to make a database? 

A. 1 

B. 2 

C. 3 

D. 4 

 

6. A field can contain… 

A. Words 

B. Dates 

C. Numbers 

D. All of the above 
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7. __________ can be classified as either ‘select’ or ‘action.’ 

A. Tables 

B. Fields 

C. Databases 

D. Queries 

 

8. The Help File can be viewed… 

A. Online 

B. Offline 

C. Neither A or B 

D. Both A and B 

 

9. The proper term for filling a database up with data is __________ a database. 

A. Updating 

B. Populating  

C. Completing 

D. All of the above are proper terms 

 

10. A trusted location can be… 

A. A folder on your computer 

B. A folder somewhere on your network 

C. A folder contained on another computer accessible via the Internet 

D. All of the above 
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SECTION 2: The New Interface 

 

In this section you will learn how to: 

 Recognize a contextual tab 

 Use the commands located in the ribbon 

 Expand extra commands using the Chunk icons 

 Use and customize the Quick Access toolbar 

 Use the Office menu 

 Use the four default ribbons 
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Lesson 2.1: Using the Quick Access Toolbar 

In the previous lesson, we introduced the new layout changes to Access. In this section, 

we will learn a little bit more about each part of the new interface and how it works. This 

lesson will focus on features and customization options available with the Quick Access 

toolbar, located in the upper left-hand corner of the screen: 

 

 

About the Default Buttons 

Access features three default commands in the Quick Access toolbar: 

 

Save  Saves the most recent changes to the current database file. 

Undo 
 

 The Undo command will revert most changes made in Access. For 

example, if you made a formatting change to a form that you were 

not happy with, click the Undo button to go back one command. 

 

There is a small pull-down arrow beside the Undo button; click this 

to see a listing of the last few tasks that were performed. Click any 

task in the list to undo all commands to that point. 

Redo  This reverses the Undo command. Useful if it is pressed to many 

times. 

Adding Buttons 

As you become more familiar with Access you might find it handy to have another 

command quickly available for use. Though the command tabs and ribbon significantly 

reduce the number of clicks it takes to do something, you might want to have a 

particular command always available. Access allows you to add the command to the 

Quick Access toolbar. 
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For example, some of us have difficulty with spelling. Fortunately, many programs 

(including Access) feature a spell checking feature. In Access, the spell checking feature 

is located in the Records section of the Home command tab: 

 

 
 

To add this command to the Quick Access toolbar, simply right-click the Spelling 

command and click Add to Quick Access Toolbar: 

 

 
 

The command (denoted by the small ‘ABC’ icon) will be placed in the Quick Access 

toolbar: 

 

 

Removing Buttons 

If you no longer use a certain command or your Quick Access toolbar is getting a bit too 

filled with icons, you can remove them easily at any time. Simply right-click on any icon 

you no longer use and click Remove from Quick Access Toolbar: 
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Customizing the Toolbar 

As you gain familiarity with Access (and other Office 2007 programs) you have the 

ability to customize how the Quick Access toolbar looks all at once versus having to add 

icons one by one. To do this, click the small pull-down arrow ( ) located on the far right 

of the Quick Access toolbar and click More Commands: 

 

 
 

(Note that you can click any command listed here to add that command to the toolbar. 

The commands that are already checked are those on the toolbar; simply click them to 

remove them.)  
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When you click More Commands, the Customize dialogue box (found in the Access 

Options) appears: 

 

 
 

This window gives you the ability to add any of the functionality from any command tab 

or contextual tab you like to the Quick Access toolbar.  
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First, click the pull-down arrow beside the Choose commands from combo box: 

 

 
 

The first category (File) is all commands accessible via the Office Menu. The next seven 

tabs are the main command tabs, the majority of which are visible when working in 

Access. (Some command tabs might not be visible at the time, depending on what you 

are doing with your database.) The third section of options are all of the contextual tabs 

that appear only when you are working with a specific database object The final section 

deals with macro commands, other miscellaneous commands, and a listing of every 

command in Access. 



 

 

 

 

46 0207 987 3777  www.MicrosoftTraining.net 

 

 

 

Pick a listing from a particular category in order to see the commands it contains. For 

example, imagine you are going to make heavy use of pictures and diagrams in a 

database form. To do this, you will need to import each picture one at a time. Therefore, 

you may find it easier to add the Insert Image icon to the Quick Access toolbar so it is 

always accessible. Select the Form Tools - Design option and then scroll down the list of 

options until you find Image: 

 

 
 

Click the Image icon to highlight it and then click the Add >> button located in the 

middle of the window: 
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This will add the Image tool to the Quick Access toolbar list on the right-hand side of 

the window. By default, the command is inserted at the bottom of the list (under the 

Undo command). 

 

You can change the order of any icons in the list by selecting an item in the Quick 

Access toolbar list and then clicking the up and down buttons on the right side of the 

list. Simply click an item in the list you would like to move up or down and then click the 

corresponding directional button: 

 

 
 

Items listed top to bottom will be displayed from left to right in the Quick Access 

Toolbar. To remove an icon from the list, select the icon and click the Remove button in 

the middle of the window.  

 

If at any point you want to return the Quick Access toolbar back to its original 

configuration, click the Reset button: 

 

 
 

This will remove all icons except for the original three (Save, Print, and Undo). 
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Lesson 2.2: Basics of Ribbons 

One of the biggest changes in Access is the removal of menus. Instead of having a list of 

menu commands to choose from (including a number of options that are grayed out 

and not accessible), Access features a more intuitive control system of tabs. Each tab 

contains a certain group of commands relevant only to the tab. The commands are 

listed in the ribbon. 

 

We will learn in this lesson how the ribbon works and some of the tools that are 

available. 

About Ribbons 

There are two main types of ribbons: general (or command) and contextual. The general 

ribbons (and corresponding tabs) are always visible when you are viewing a database 

file in Access: 

 

 
 

The command tabs listed here include many of the most common commands you will 

perform in Access. The Home ribbon contains the majority of the most common tasks 

including the ability to switch views, formatting, and filtering of data. If you want to 

make a new database object, click the Create tab and select the object you want to 

make. The External Data command tab gives you all the flexibility to import and export 

data to and from your database, computer, and network. The Database Tools tab gives 

you the ability to manage the data in your database, create macros, and view 

relationships. 

 

Contextual tabs appear only when a certain type of database object is selected (or 

brought into context). For example, if you are looking at a table in datasheet view, a 

contextual tab will appear showing you the commands you can perform on the table 

while only in datasheet view: 

 

 
 

When using a command in the ribbon, simply click it with your mouse. The command 

will be performed, or the appropriate tool or dialogue box will appear to help you 
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perform the task. If you are unsure what a certain command does, point to it, but do not 

click it.  

After a quick moment a description will appear. This is true for most of the commands: 

 

 

Opening Dialogue Boxes from the Ribbon 

Occasionally you will see a small arrow icon beside the name of a ribbon command 

category: 

 

 
 

Clicking this little icon opens a new dialogue box containing more advanced 

functionality than is provided by the ribbon alone. In the example above, clicking the 

Clipboard button opens the Clipboard pane on the left side of the Access window.  
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As you work with Access and use more features, you will discover more of these options 

scattered throughout Access. 

About the File Menu 

The Office Menu should be pretty familiar to you now. We have learned that you can 

open and close files, modify the Access program options, and close Access; all by using 

the Office Menu. If you have used Access in the past, the Office Menu is very similar in 

functionality to the File menu in previous versions. 
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Let’s take a look at the commands in the File menu. 

 

Info 

 
 

 

The File, Info option displays Compact & Repair Database. This is 

useful if you are planning to send the database to another 

person so they can work on it. This command checks the file for 

errors and compresses the file size a bit by eliminating wasted 

space. (If you have ever defragmented a hard drive before, the 

principle is the same.)  
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Encrypt with Password adds a level of security to the database.  

However, to password protect a database you must first open it 

exclusive.  

    
 

After opening Exclusive select File, Info, Encrypt with Password 

and enter a suitable password. 

 

Similarly, to unset the password the database must be opened 

Exclusive.  

New This will close any open database files and open 

the Getting Started page. Click Blank Database 

to create a new empty database file. 

 

 

Open Opens a dialogue box allowing you to search your computer or 

network for a file. 

Save Saves any modifications you have made to the current database 

object. 

Save As Allows you to save the currently open database object under 

another name. This is useful if you want to perform a major 

revision or update to a particular object. 

Print The Print option has three different parts.  

Clicking Quick Print sends the current report or object 

immediately to the printer.  
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Selecting Print 

displays a dialog box 

from which you can 

choose all or 

selected records. 

 

Print Preview lets 

you view the current 

database object as it 

would look if printed on a piece of paper. We will explore more 

printing options later in this manual. 

Close Closes the current database file. 
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Account 

 
This menu option displays User information, Connected Services 

and information about the Access Product.  
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Options 

 
These are the default Access options that control settings such as 

the Access file format, editing behavior, autocorrect and 

language options and displaying forms in tabs rather than 

dialogs.  

Other options let you customize the Ribbon and Quick Access 

Toolbar and control Trust Centre settings. 
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Lesson 2.3: The Home Ribbon 

In the following lessons we will explore what commands are included in each command 

tab and their function. We will start with the Home command tab and ribbon, which 

contains most of the commonly used commands for databases and working with data 

using Access. Remember, this is just an overview; don’t worry if you don’t understand 

what particular commands do. This is just so you know where to find a command when 

we begin discussing it.  

 

 

Views  

Click the Views command to cycle through the different views available for each object. 

(The type of views available will differ depending on the object that is currently open.) 

 

You can also click the small down arrow underneath the word View to see all of the 

available views: 

 

 
 

Clipboard 

The Clipboard is a special part of the memory of your computer. It is designed to hold 

an object in temporary memory until it is either placed somewhere else or copied over 
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when a new item enters memory. Before the newer versions of the Windows operating 

system, a computer could only hold one item at a time in memory. The Office packages 

have expanded this to a full twenty-four objects whether it is text, spreadsheet data, 

pictures, or some other piece of data. Items are placed on the clipboard either by 

selecting some text or object and pressing Ctrl + C on your keyboard. Ctrl + V will paste 

the object to a new location. 

 

Access gives you full control of the clipboard on your computer. Select an item and use 

either the Cut or Copy command, followed by the Paste command. The other command 

in the Clipboard section of the ribbon (marked Format Painter) is only applicable when 

designing forms or reports and will be covered later. 

 

 
 

Click the Clipboard button (circled in red above) to expand the clipboard and its 

contents: 

 
 

You can empty the clipboard at any time by clicking the Clear All button. Or, you can 

delete individual items by right-clicking on an item and selecting Delete. 
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Font 

The Font section of the Home ribbon contains all the commands you need to modify 

how a font looks: 

 

 

 
 

Alternate row colour 

 

Any of the options that have a small pull-down arrow contain more options than a 

simple toggle on and off; click the pull-down arrow to see all available options. You can 

also use the button in the lower right-hand corner to expand different formatting 

options for a particular database object. 

Rich Text 

Access allows you to take certain text fields further with the addition of Rich Text 

options: 

 

 

Alternate row 

colour Alternate row 

colour 

Bullets and 

Numbering 

Increase and decrease 

indentation 
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Records 

The Records section of the Home ribbon deals with basic data management: 

 

 
 

The Refresh All command is designed to re-retrieve all the information from the 

database file. This option becomes particularly useful if your database includes any 

external data sources (explained later in this manual). If you only want to refresh the 

data for the current object, click the small pull-down arrow beside the Refresh All 

command and select Refresh. 

 

The other commands will generate a new record in the object, save any record changes, 

delete a record, apply a calculation field like sum or average, and check the spelling of 

the current object. 

 

Clicking the pull-down arrow beside the More command will show a small menu of 

more commands that can be performed on the current object: 

 

 
 

We will explore some of these commands later in this manual. 
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Sort and Filter 

The Sort & Filter section of the Home ribbon will apply some sort of organizational 

method to a database object: 

 

 
 

For example, if you wanted to sort a list of names alphabetically, simply click the column 

header to select the entire column of names and then click the Sort Ascending 

command. (We will cover how to perform operations on a table of data later in this 

manual.) 

Find 

If your database should grow substantially in size some day, finding a particular value by 

hand quickly becomes impractical. Access features a Find command to track down the 

value you are looking for: 

 

 
 

Simply enter the search criteria you are looking for and Access will search the current 

database object to retrieve the information you are looking for. 

 

As an addition to the Find command, Access can also replace certain values based on 

search criteria. For example, if you misspelled a place name or if someone’s last name 

has changed, you can use the Replace command to find all instances of a value and 

replace it with something else.  

 

Use the Go To command to browse the various records that meet your search criteria. 

You also have the ability to select an entire row of data containing a ‘found’ value or 

select the entire object containing the found value(s). 
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Lesson 2.4: Create Ribbon 

We continue in this section with our exploration of the next main ribbon, the Create 

Ribbon. The Create ribbon is used to make new database objects:  

 

 

Tables 

Tables are the main objects used in databases. (Without tables, and thus without data, 

you don’t have much of a database!) We learned in Section 1 of this manual that a table 

contains one or more records (or rows of data) and a record contains one or more fields. 

So, use this section of the ribbon to create the tables you need in order to store the data 

for your database. 

 

 
 

Let’s look at the different options in this section. 

 

Table This will open a new empty table in Datasheet view. You can 

directly enter data into the field this way or enter Design view 

to modify the structure of the table by hand. 

Application Parts 
Templates 

Use the small pull-down arrow to select part of a database. 

Can add pre-made components of a database: 
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A new table template opens in Datasheet view with a number 

of pre-defined columns. You can start entering data into the 

table right away. 

SharePoint Lists SharePoint Lists are a bit beyond the scope of this manual. 

Essentially they are tables of data that can be linked to another 

table stored on a SharePoint server across the room or across 

the world. 

 

 

Table Design Clicking the Table Design command opens a new empty table 

in Design View: 
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Here you can begin the custom construction of the table as 

you need it. We will explore more of the functionality of table 

Design view later in this manual. 

Forms 

Forms are a way of entering data into a table one record at a time. Forms in Access are 

comparable to paper forms you would fill out in an office. With a paper form, there is a 

space for each piece of data required, and once the form is filled out, it will get filed 

somewhere. The same is true in Access, as you need to have at least one table of data, 

query, or report in order to make proper use of a form. Use the commands in the Forms 

section of the Home ribbon to perform different form actions: 

 

 
 

Form Use this command to create a new form based on the last 

highlighted object in the Navigation Pane. Each field in the 

object will be made into a new field in the new form. (We will 

explore the use of forms later in this manual.) 

Form Design Clicking the Form Design command opens a new empty 

form in Design view. You can begin constructing a new form 

right away. 
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Blank Form Use this command to create a new empty form. 

Form Wizard This allows you to easily create different types of form from 

a single table or multiple related tables. 

More Forms This command features more advanced commands relevant 

to the use of forms to help you create a form without having 

to build it manually: 

 
Multiple Items creates a special kind of form that lets you 

view more than one record at a time. Multiple item forms are 

beyond the scope of this manual but are very useful in 

certain situations. 

 

Split form allows you to enter information into a form while 

you view the table, query, or report data. 
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Reports 

Reports are primarily used to summarize the data returned by a query. Reports can also 

be used to create a complete table contents listing suitable for printing. 

 

 
 

Report Clicking the Report button creates a very 

simple report based on the last 

highlighted object in the Navigation 

Pane. We will explore the use of reports 

later in this manual. 

Report Design This command will open a new blank 

report in Design View where you can 

start to manually build a form right away. 

Blank Report This command opens an empty report. 

Report Wizard This command will walk you through the 

steps of creating a report based on 

another database object. The wizard will 

walk you through the placement of fields 

as well as a style and layout that works 

for you. 

Labels There is a good chance most of the 

databases you will use will have some 

sort of contact table containing names 

and addresses. Access features the ability 

to create a mailing list based on the data 

in a table.  
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Macros & Code 

The Macro section of the Create ribbon is devoted to the construction of queries and 

macros: 

 

 
 

Macros are a set of instructions that you can tell Access to perform. For example, if you 

are performing a fairly large task with many steps frequently in Access, you can design a 

macro. It works like a script given to a performer; they read the script and deliver the 

performance the same way each time. 

 

Visual Basic This command launches the Visual Basic editor. This 

program is used to develop VBA code (Visual Basic for 

Applications) designed to do background operations in a 

database. 
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Lesson 2.5: External Data Ribbon 

If you are just starting out with Access, chances are the majority of the databases you 

will use will be contained on a single machine. You will also likely enter most of the data 

by hand. This is fine for small databases, but Access gives you the ability to import data 

from nearly any source and from a wide variety of programs. In this lesson we will learn 

a little bit more about the External Data ribbon. 

 

 

Import 

The Import section allows you to bring in data from many different sources, including 

other Microsoft Office programs. 

 

 
 

Saved Imports Allows you to retrieve information for a specific source many 

times. For example, if you extract information from a 

Microsoft Excel spreadsheet on a regular basis, you can 

choose to save the import operation so you don’t need to 

set up the same import over and over again. 

Access This command lets you import data from another Access file 

or link to the data contained in a file. 

Excel The Excel command lets you import data from an Excel file or 

link to the data contained in a file. 

ODBC Import or link to an ODBC (Open Database Connectivity) 

such as an SQL server. 

Text File If you have a large amount of data that is in an organized 

structure, you can import that data directly into your 

database file and have Access format it for you. 
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XML File Import the data from an XML (Extensible Mark-Up Language) 

file directly into a table in your database. 

More Access features the ability to import data from SharePoint 

lists, other database programs and HTML documents. Click 

the appropriate file type command to start importing that 

particular type of file: 

 

 

Export 

In addition to being able to import data from a number of sources, Access can also 

export data to several different sources. 

 

 
 

Saved Exports If you frequently export data to a particular location or 

program, you can save the export operation for later use, 

thereby eliminating having to set up the export each time. 
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Excel Export the data contained in an object to an Excel 

spreadsheet. 

Text File You can export the data contents from a database object to 

a plain text file that is usable on virtually any computing 

platform. 

PDF or XPS This option enables the contents of a database object to be 

distributed to others as a PDF or XPS files. This means you 

can see database objects without having the need for Access 

to be installed in every location. (This option may not be 

available if you have not downloaded and installed the PDF 

add-in from the Microsoft Web site.) 

Email This option allows you to email an attachment to a recipient 

in a format such as Excel or HTML. 

More Access allows you to export to other file types such as Word, 

HTML, SharePoint and an ODBC database. 

 

 

 

 

Web Linked Lists 
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Work Online Connect to the SharePoint server. 

Synchronize If you have been doing work on a file that is linked or shared 

with a SharePoint server, you can use this command to 

update all linked or associated files. Similarly, if you received 

notice that data on the SharePoint server had been updated, 

use this command to update your own data as well. 

Discard Changes If you are working with your shared files and discover that 

you made an error or were performing a task the wrong way, 

use the Discard Changes command to revert the shared data 

back to its previous state. 

Cache List Data Copy the current SharePoint list to the local hard drive. 

Relink Lists Inevitably in every organization, some sort of equipment 

failure or computer trouble will disrupt your working day. 

Should you or others using a SharePoint server experience 

trouble with connections, you can use this command to re-

establish any lost connections. 
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Lesson 2.6: Database Tools Ribbon 

The Database Tools ribbon is the last of the four main command ribbons. It contains 

most of the advanced and background commands used on an established database. We 

will explore the basics of this ribbon’s functionality in this lesson. 

 

 

Macro 

 
 

 

We defined a macro earlier as a set of instructions you can save to use again and again 

on a database. A macro can be used to encompass nearly every command in Access, as 

well as extra functionality defined by a programmer. 

 

 

 
 

 

Relationships Nearly every database that contains multiple tables also 

includes a relationship between the information contained in 

the database file. For example, if you work at a department 

store, each item likely has some department identification 

number associated with it (1, 2, 3, etc.). In the store database 

there is another table that lists the corresponding 

department name with a number (1 = ladies wear, 2 = 

furniture, 3 = kitchen & bath, etc.). The table of items and 
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the table of departments share a relationship in that the 

values of one are related to the values of another. We will 

explore relationships later in this manual. 

Object Dependencies As you develop more relationships in your database and 

build more forms, reports, and queries, you will develop a 

large number of dependencies. That is, one object, such as a 

query, depends on many others in order to fulfill its job. 

Click this button to view these dependencies. 

Analyze 

The Analyze section of the ribbon is used to examine how your database is built and 

how will it will perform. Database performance, as well as the terminology and 

methodology behind it, is used mainly by database engineers. However, Access makes it 

easy to perform some optimizations to your data without you needing a PhD in 

computer science! 

 

 
 

Database Documenter The Database Documenter tool is used to thoroughly list 

every feature and property of a database object or group of 

objects. 

Analyze Performance This command is a special part of Access that can tell you 

where you may be able to make improvements to the design 

of your database. For example, if you end up with duplicate 

tables or a table, the analyzer can find these and suggest 

some optimizations to increase the performance of your 

database. 

Analyze Table This command launches the Table Analyzer Wizard. This tool 

works like the Analyze Performance command, but on a finer 

scale and one table at a time. 
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Move Data 

The Move Data section of the ribbon is used to perform large scale move and split 

operations to a database. These commands are beyond the scope of this manual and 

should only be performed by IT professionals. 

 

 
 

SharePoint This will move your tables to a SharePoint List. 

Access Database In certain corporate situations, it may be useful to split up 

your database across two or more locations such that the 

tables are situated in one location and other database 

objects are in other locations. This command will open a 

wizard that will help you do just that. 

 

 

 

 
 

Add-Ins An add-in is a special type of third-party program or VBA 

code that is used to provide extra or specific functionality to 

the Access interface. If you are familiar with plug-ins used in 

an Internet browser, the principle is essentially the same.  
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Section 2: Review Questions 

 

1. Which commands can be added to the Quick Access toolbar? 

A. File management commands 

B. Editing and interface commands 

C. Importing and exporting commands 

D. All commands can be added 

 

2. You have opened a table in Datasheet view. A new __________ ___________ appears: 

A. Formatting dialogue 

B. Contextual tab 

C. Database window 

D. SQL viewer 

 

3. If you wanted to import an Excel spreadsheet, which ribbon would you use? 

A. Home 

B. Create 

C. External Data 

D. Database Tools 

 

4. Which command in the Office menu creates an identical copy of your current file? 

A. Compact and Repair Database 

B. Back Up Database 

C. Database Properties 

D. None of the above 

 

5. Which command in the Office menu optimizes size and fixes problems with your file? 

A. Compact and Repair Database 

B. Back up Database 

C. Database Properties 

D. None of the above 

 

6. The Replace command is an extension of the ________ command. 

A. Search 

B. Find 

C. Retrieve 

D. None of the above 

7. The Labels command ( ) is part of the __________ section of the ______ ribbon. 
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A. Create, Reports 

B. Create, Other 

C. Reports, Create 

D. Reports, Home 

 

8. Access lets you save ________ commands to use at a later date. 

A. Import 

B. Format 

C. Export 

D. Both A and C 

 

9. You can import data files from… 

A. Other Access files 

B. Text documents 

C. Excel files 

D. All of the above 

 

10. You can analyze the performance of and optimize which database object? 

A. Macros 

B. Queries 

C. Forms 

D. All of the above 
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SECTION 3: Creating a Database 

 

In this section you will learn how to: 

 Recognize the use of databases for your situation 

 Use and recognize different database objects 

 Navigate through a table in Datasheet view 

 Add, edit, and delete records 

 E-mail a portion of a table to someone else 

 Create a table from scratch and from template 

 Cut, copy, and paste data 

 Undo and redo actions in Access 

 Use the Format Painter 
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Lesson 3.1: First Steps 

Making a database might seem like a pretty big job, but taking the time to design one 

properly will save a lot of time down the road. You are exposed to databases everyday 

use them all the time probably without knowing it. In fact, you are likely in several 

yourself! 

 

The easiest method of identifying yourself in day to day life is a simple handshake and 

saying “Hello, my name is…” But you can’t really shake hands with a computer. Using 

your name, even your full name, isn’t a very good option either because there may be 

hundreds of people out there with exactly the same name as you. Therefore, you must 

be assigned some unique identifier, the most recognizable being your Social Security 

Number (SSN) or Social Insurance Number (SIN). No one else in the country has the 

same SSN as you. 

 

This practice holds true for databases, too. Earlier in this manual you may recall seeing 

the term ‘primary key’. Every row in a table should have at least one field that is unique 

from every other record. That field is usually a number, and the unique field is referred 

to as the primary key. It is not imperative to have a primary key, but it makes the design 

of the database much easier and eliminates the possibility of duplicate data (which does 

nothing but confuse the issue!) It also allows a database program to (in most cases) 

search faster and more efficiently. Therefore, it is good practice to have a primary key 

for every table you make. 

  

Let’s quickly review what we know about databases: they are made up of tables, and in 

each table are several records (or rows) of data. Every record is made up of one or more 

fields, and every record in a table is different from every other record because of the 

unique primary key. Knowing this, and with the knowledge of the commands we learned 

so far, we are ready to start making databases! 

 

For the remainder of this manual, let’s pretend that you are Bugs Rabbit, CEO of an 

upstart animation company, Warner Cousins. You want to use Access to monitor the 

expenses made by you and your employees. 
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Planning a Database 

Before you start using Access to create a database, take the time to answer a few 

questions:  

 

 Why do you need a database? You want to keep track of the expenses made by 

you and your employees. 

 Who will be using the database? Any employee of Warner Cousins will have 

access to this database. 

 What kind of data would be extracted from the database? Total expenses of the 

company, total expenses by each employee, expenses by each category. 

 

Once you have answered these questions, it is time to decide how to design the tables 

for your database. What fields of data do you need? What data types will the fields need 

to be? What tables would be important? Which fields will go in which table, and do the 

placements make sense? 

 

Next comes the planning of relationships between the data. A big list of numbers 

doesn’t mean much by itself, but when constructed based on other data, it becomes 

meaningful. And finally, make sure that you talk to everyone who will be using the 

database will be able to get the data they need. Let’s examine some of the details. 

 

You will obviously need an expense table that contains at least the following: who made 

the purchase, what did they purchase, how much was it, and when did they purchase it? 

 

The payroll department already has a listing of the people who work for you: 

 SIN (or company ID #) 

 Name 

 Address 

 Phone Number 

 Company Position 

 

The database now should have two tables: an expenses table and an employee table. 

Now, there needs to be some sort of link between the two tables. You could use the 

name of each person, but that may become confusing, especially if your company grows 

into the hundreds. There is another option, however. You can use the SIN (or company 

ID) of each employee to tie their purchase to their personal information. 
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In database design, your most powerful tool is not the computer, but rather a piece of 

paper and a pencil (and a big eraser). Not only can you easily change the information 

you might need, but you can also visualize the information.  
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Consider the following diagram, based on the paragraph above: 

 

 
 

It might not look like much, but we have a database. It contains fields, records, a primary 

key for each record in each table, and a relationship between the data. We can see that 

employee 2 has made two purchases, and employee 1 only one. This might seem silly 

for an example of this size; why not just say Elmer Funn instead of an employee ID? As 

mentioned above, this becomes impractical if your organization grows. Imagine that 

your company has grown to employ thousands of people with hundreds of expenses a 

day – that becomes a pile of data in a big hurry! You might employ three or four Elmer 

Funns by now, so using a unique number to identify each employee becomes much 

more practical. 

Creating a Database from a Template 

When you launch Access you will see a wide selection of templates available.  You can 

choose one or select from a category. 
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Once you have chosen a template, choose a save location (default of My Documents) 

and then click Create to download the template. 
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The template will open containing a number of pre-built database objects, including 

tables and relationships between the tables. Start entering data or modify the design of 

the objects as you see fit. 

 

Access may offer a choice of whether to include or remove the sample data. 

 

 

Creating a Blank Database 

Although Access contains a number of templates already built in, it is important to 

understand how to create a database from scratch.  

 

From the Getting Started page, click the Blank Database link in the center of the Access 

window: 
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On the right side of the Access window, select a location (default of My Documents) to 

save the database and click Create: 

 

 

 

That’s it! A new, blank database will appear in the Access window. 

Using Database Objects 

A database object is defined as some individual piece of a database that can be used on 

its own. We have discussed the major objects: tables, queries, forms, reports, and 

macros.  

 

The Navigation Pane is used to control and use the objects of an Access database. 

Expand the Navigation Pane ( ) and click the pull-down arrow beside the title to show 

the full Navigation Pane toolbar.  
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Then, click Object Type to display all objects currently in the database: 

 

 

 
 

All objects currently in the database are categorized by their object type: 
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If you want to see the different objects in each category, click  to expand that 

category. Each object contained in each category is listed in alphabetical order: 

 

 
 

To open an object, simply double-click it. It will open in the main part of the Access 

window and will have its own identifying tab.  
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Some objects, such as the report, include a time and date stamp right on the object: 

 

 
 

Access lets you rename or delete objects in your database. However in order to do so, 

the object must first be closed. If you need to delete or rename an object, you can do so 

by making use of right-clicking. To do this, point to an object and click the right mouse 

button. A pop-up menu will appear giving you quick access to certain commands:  

 

 
 

If you click Rename, simply type a new name for the object, and then press Enter: 
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If you need to delete an object, Access warns you that the delete operation cannot be 

undone:  

 

 
 

Click Yes to delete the selected object. 

 

Navigation Options 

Right click on the Navigation Pane to view Navigation Options. 

The following dialogue box is taken from the Northwind Sample database: 
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This dialogue box contains three main parts: a category list, a group list, and a few other 

options. 

 

The first two options in the Categories list are fixed (Tables and Related Views and 

Object Type). However, you can create as many custom categories as you like. For 

example, the Northwind Traders category was added specifically for this database.  

 

If you highlight the custom category, you have the ability to move it up and down 

through any custom categories you may have created: 

 

 
 

Use the Delete Item and Rename Item buttons at the bottom of the categories list to 

perform the associated action on the selected category. If you ever need to delete a 

category, the objects that were in the category will not be deleted. 

 

On the right-hand side of the Navigation Options dialogue box is a list of groups that 

are included in a category. For example, the groups contained in the Object Type 

category we have already used previously in this manual: 
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Highlighting the Northwind Traders category will display all of the custom groups used 

in the category: 

 

 
 

Note that there is one group that is always present in a custom category: Unassigned 

Objects. 

 

The options at the bottom of the dialogue box give you a bit more flexibility when it 

comes to the displaying of objects: 

 

Show Hidden Objects If you find your database growing to a level that can be a bit 

hard to manage, you have the ability to hide certain objects. 

This means that they simply won’t be shown in the 

Navigation Pane and can make it easier to find the object 

you need. Checking this check box will override any Hide 

command that you give to an object. 

Show System Objects There are some background objects and tables that Access 

uses when you are using a database. Check this box to 

display them. 

Show Search Bar If you end up with a very large and complex database, and 

would rather not hide any objects, you can use a small, 

simple search bar which will then appear at the top of the 

Navigation Pane: 
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Enter the name of the object you are searching for. As you 

type, Access will automatically filter the different objects 

based on the keyword you are inputting. 

 

The search bar does not, however, give you a direct list of 

results. Instead it filters the relevant names for each group as 

you type. For example, if you know the object you are 

looking for includes the word ‘order’, begin typing it into the 

search bar. Access will show you all of the relevant results: 

 

 

 

Lastly, you have the option to open an object from the Navigation Pane using either a 

single click (like a Web page hyperlink) or double-click (default). 
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Lesson 3.2: About Records 
 

 

So far we have come a long way in our exploration of Access. By now you should be 

comfortable with the basics of navigating the interface and the use of the Navigation 

Pane. We are now ready to explore the real stuff databases are made of, as well as begin 

to build one of our own. 

What is a Record? 

We defined a record in Section 1 of this manual as a collected group of fields. More 

formally, a record is defined as one or more fields of data that create a single entry in a 

table. We have also learned that each record should have a primary key; that is, some 

unique identifier that sets it apart from every other record in a table. 

Navigation Tips 

Imagine you are working on this simple table in Datasheet view: 

 

 
 

Before discussing how to move around inside a table, let’s take a quick look at the 

features Access has automatically added. The ID field was automatically inserted to use 

as a primary key. Every table should have a primary key of some sort, but it is not 

necessary.  

 

Field1 and Field2 are column headers that identify a column of data. The last field, Add 

New Field, is also an automatic placement by Access. This is not a column of data like 

the others, but can easily become one should you need it. 
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The field in the upper left-hand corner is currently highlighted in orange. To move the 

cursor to a different field you can use the mouse and click inside any other field. You 

can also use the arrow keys on your keyboard to move the selection to a different field. 

 

Using the mouse and keyboard is fine for tables of data that can fit on your screen; 

however the majority of tables in databases are usually quite long. It becomes 

impractical to scroll up and down or press and hold the arrow keys to reach your 

destination. There is a small toolbar at the bottom of Datasheet view available to deal 

with this exact problem: 

 

 
 

To browse through the various records, use the small arrow icons: 

 

  First Moves to the first record in the table. 

  Previous Moves to the previous record. 

  Next Moves to the next record. 

  Last Moves to the last record in the table. 

  New Creates a new record at the end of the 

table. 

 

You can also apply a custom filter to the table by clicking the filter button. Access also 

lets you search for a particular entry by using the Search text box. Simply type in the 

keyword or number you are looking for and press Enter. 

 

At the very bottom of the Access window, in the status bar on the right-hand side of the 

screen, you will see a few small icons. These icons denote which view you are currently 

using to work with the current object. In the diagram above, the available views of a 

table are listed (Datasheet view which is currently highlighted, and Design view). 
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Adding Records 

There are a few different ways to create a new record. Try using all of them; depending 

on your level of experience with using computers you will likely find one that is easy for 

you to use.  

 

The first method is likely the easiest if you are very comfortable using a keyboard. If you 

are entering data using the keyboard, enter the data you need into a field and press 

Enter on your keyboard. If you have reached the Add New Field column of data and 

press Enter again, you can now type in that column. Pressing Enter once more will bump 

the Add New Field down one column, and so on until you have added as many fields as 

you like to a record.  

 

If you are entering data using the keyboard, pressing Tab will also advance you to the 

next field in the row. However if you have reached the end of the record and press Tab 

again, you will move to a new record. 

 

The second method is using the Home ribbon. The Records section of the ribbon 

contains a New record command ( ); click this to make a new record at the end of 

the table. 

 

The last method is by using the navigation bar located at the bottom of Datasheet view: 

 

 
 

This will create a new record at the end of the table. 

Editing Records 

If you made an error, or need to change the information in a record manually, simply 

open the table containing the data, scroll to or search for the data field you need to 

change, click inside the field and enter the new information. As you are entering data 

into a table, a small pencil icon will appear to the left of the record you are currently 

writing:  
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It is important to note that Access provides a little peace of mind by saving data 

automatically after every change to a data field. It is not necessary to manually save the 

database after every change. The only field you cannot modify in this way is the primary 

key. If there is some reason to modify the primary key, it is best to simply delete the 

record (described below) and make a new one with a new primary key. 

Deleting Records 

Consider the following table:  

 

 
 

If you want to delete a single record, click any of the boxes to the left of a record. This 

will select the entire row of data: 

 

 
 

Click the small pull down arrow beside the Delete command in the Home ribbon and 

click Delete Record: 
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Access warns you that you are about to delete a record: 

 

 
 

Click Yes to confirm the deletion. Alternately, you can right-click the box to the left of 

the record and select Delete Record from the pop-up menu: 

 

 
 

Deleting records in this manner is fine for a few, but impractical if you need to purge a 

lot of data from a table. Luckily, Access allows you to delete multiple records at once. 

However, as a safety feature, you can only delete groups of adjacent records. That is, 

you can’t merely pick and choose which records you want to delete and delete them all 

at once. 

 

To select a group of records, click the box to the left of the first record you want to 

delete in order to highlight that row: 
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While holding the Shift key down, click the box beside the last record you want to 

delete. This will highlight a block of records: 

 

 

 
 

Now click the Delete command on the Home ribbon and click Delete Record. You will be 

warned this operation cannot be undone; click Yes to confirm the deletion.  

 

If you prefer to use the right-mouse button, make sure you are still holding the Shift 

key, and then right-click any of the boxes to the left of the selected records. Click Delete 

Record and then Yes to confirm the deletion. 

E-Mailing Records 

Access allows you to e-mail records from a table in many different file formats. To 

perform this operation, first select a record by clicking the box to the left of the record 

and highlighting the row, or hold the Shift key and then select a group of records.  

 

For example, if you wanted to send records 3 and 4 from the table below, first highlight 

both records: 

 



   

 

 

www.MicrosoftTraining.net  0207 987 3777 97 
 

 
 

Click Office Menu  E-mail: 

 

 
 

This will open the Send Object As dialogue box: 
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Here you can choose which type of file format you want Access to convert your data 

into before sending. If you are not sure which file format to use, selecting PDF Format (if 

you have installed the add-in) or Text Files will likely be your best option. These two file 

types can be read by virtually every computer platform. 

 

Make sure the Selection radio button is selected in the Output section of the dialogue 

box. Click OK. This will open a new message in your default mail program (like Microsoft 

Outlook or Outlook Express) with a special attachment in the file format you have 

specified.  

Enter the recipient’s e-mail address and click Send: 

 

 
 

If you click the All radio button in the Send Object As dialogue box, Access will package 

the entire database object in the file format you specify and then attach it to a new e-

mail message. 
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Printing Records 

Office gives you the ability to print a selection of records. First, highlight the record(s) 

you would like to print:  

 

 

 
 

Click Office Menu  Print: 
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When the Print dialogue box appears, specify the Print Range you would like to use and 

the number of copies: 

 

 
 

Click OK to print the records. You can also select to print the entire object or only 

certain pages of the object; we will cover more advanced print topics later in this 

manual. 
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Lesson 3.3: Creating a Table 

In this lesson we will learn more about the usage of tables, including how to build them 

from scratch.  

About Tables 

You should be very familiar with the components of tables by now. We know a table is 

made up of several records each containing fields with data. Access also makes it easy 

to build and modify any component of a table using Design view, which we will cover 

later in this manual. 

 

When designing a database, it is critical that you take the time to design your database 

carefully. Although it is not a difficult job to make some adjustments to a field, adding 

or removing fields in a large established database can be a real headache. It is important 

to communicate with everyone who will be using the database to make sure that 

everyone has the information they will need. Don’t be afraid to build a database a little 

bigger than you think it needs to be; if you end up with unused fields they are much 

easier to take out than to put new fields in. 

Creating a Table 

Access gives you the ability to create a table in a few different ways: opening an empty 

table and inputting values, using a template, or using Design view to construct your 

table by hand. 

 

Use the Tables section of the Create ribbon to make a table:  

 

 
 

 

Empty Table Click the Table command to open a new empty table A new tab 

will open, containing an empty table in Datasheet view: 
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Click inside the Add New Field column and start entering data. 

Press Enter to keep adding fields to the record, then press Tab or 

click the  command to make a new record. 

Tables from 
Application Parts 

As well as starting with one of the Access templates, Application 

Parts offers a variety of pre-built tables, forms and reports.  

 

 
 

For example, from Quick Start clicking Contacts creates a contacts 

table and form together with a contact telephone list and address 

labels. Choose Tasks to create a table and form for entering tasks 

with start and finish dates, priority and % progress.   
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Table Design 
View 

Click the Table Design command to open a new blank table. A new 

section of Access we have yet to explore will appear: Design view 

for a table:  

 

 

 

Design view includes its own Design ribbon in a contextual tab. You 

have the ability to add a primary key, construct custom formulas, 

insert or delete different fields, and more. 

 

Using Design view is more in-depth than simply entering data into 

fields. 

 
 

At the bottom of Design view is the Field Properties section. Here 

you can modify all of the properties of a particular field.  
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 For example, if you want to have a Price field in your database:  

 

 
 

Give the field a name, and then choose a data type for the field. A 

data type can be a word, number, currency, date, time, etc. The 

properties of the Price field (once defined as a number) include how 

large a price it can be, the number of decimal places, if the field 

should contain a default value (like $5.99), and more. As we use 

tables more we will explore more of the details regarding Field 

Properties. 

Entering Data into a Table 

Access provides you with a few ways of entering data. You can enter in the data 

manually, use a form, or use the Import commands in the External Data ribbon.  

 

To enter data manually, open a table in Datasheet view by double-clicking its name in 

the Navigation Pane. If you make an error while entering data, like accidentally entering 

a word into a number field, Access will prompt you with an error stating so.  
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For example, if you try to enter non-numeric characters into the SIN field of the Warner 

Cousins database, you will see the following appear: 

 

 

 
 

There may be an instance where it is necessary to have both letters and numbers in the 

same data field (such as the Phone field). Luckily, the Text data type allows you type in 

any characters you like. 

 

The next method of entering data is by the use of a form. We defined a form earlier as a 

way of entering data into a table one record at a time. In the picture below, Access 

constructed a simple form based on the Employees table when the Form command was 

clicked in the Create ribbon: 
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You may recognize the navigation buttons at the bottom of the form. You can use these 

buttons to move back and forth through the records in a table as well as create a new 

record: 

 

 First Moves to the first record in the 

table. 

 Previous Moves to the previous record. 

 Next Moves to the next record. 

 Last Moves to the last record in the 

table. 

 New Creates a new record in the table. 

 

In the very bottom right-hand corner of the careen are the icons to switch (from left to 

right) between Form View, Layout View, and Design View. The picture above is in Form 

view, the ‘highest level’ view. Layout view is new to Access; it acts as a bridge between 
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Form and Design view. Essentially, it allows you to view records as you would in Form 

view while still being able to move and modify the pieces of the form. 

 

If you enter Layout view and click a piece of the form (called a control), you can move 

the piece up and down through the order of the existing controls: 

 

 
 

If you click the small four-way orange arrow at the top of your screen, you will select all 

of the controls in the form at once: 

 

 
 

Click and drag your mouse to move the controls as a group. We will explore more of the 

functionality relating to forms and form design later in this manual. 

 

 

Formatting a Table 

Access has always given you a great amount of flexibility when it comes to modifying 

the look and feel of the objects in your database. Access is no different, letting you 

modify just about everything you can think of.  

 

Entering Text If you create a new table and enter some data, the result is 

straightforward and clean: 
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If you have ever used Access before, chances are you noticed one 

of the new enhancements right away – the alternating 

background colors in the different rows of the table. You can 

modify the background color by clicking the Font button in the 

Home ribbon: 

 

 

Font Options The other commands in the Font section of the Home ribbon let 

you modify the font, font size, text style, orientation, gridlines, fill 

color, and more, for the entire table. Any modifications you 

perform will be applied to the entire table. 
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Row Height / 
Column Width 

Occasionally you may have very large (or very small) amounts of 

data to put into a table. For example, Access features a Memo 

data type that can hold a total of 65,535 characters – that’s about 

40 pages of solid text! You can expand the dimensions of rows 

and columns in order to be able to view the contents of a table. 

 

To do this, click the More command in the Records section of the 

Home ribbon. In the pop-up menu you will see entries for Row 

Height and Column Width: 

 

 
 

 

 With Row Height, you can specify a unit of measurement or leave 

it at Standard height: 
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With Column Width, you can specify a unit of measurement for 

width or choose Best Fit, which will automatically adjust the 

column to the width of the widest field’s entry: , 

 

 
 

You can also adjust the row height and column width manually. 

Place your mouse on the lines dividing the rows and columns 

from each other. Your mouse will turn into a double-headed arrow 

(  for rows,  for columns). Click and drag in the dimension 

displayed by the arrow to drag the height or width. 
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Lesson 3.4: Formatting Text 

To a computer, any data you enter into a database is stored in a certain way for Access 

can easily retrieve it later on. However, people may like to have the data presented in a 

nice way that is easily readable or in a color scheme that matches their particular 

company. In this lesson, we will explore how to you can easily change the look of text in 

tables, forms, and reports. 

Using the Zoom Box 

The Zoom Box is a special part of the Print Preview command. It is used to quickly zoom 

in and out to confirm the look of your document before you print it. For example, if you 

create a report based on the Employees table of the Warner Cousins database, the 

report will be shown in Layout view. To switch to Print Preview, click the icon located in 

the bottom right-hand corner of the window: 
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The Print Preview mode of Access features its own ribbon. The zoom box is located in 

the bottom right-hand corner of the Access window: 

 

 
 

 
 

Click the + or – buttons to increase or decrease the level of zoom. You can also click and 

hold the small slider control in the zoom box and click and drag a custom level of zoom. 

Use the zoom box in combination with the Preview commands in the ribbon to see as 

many as twelve pages of report at once. At any time you can click the number beside 

the minus button to jump between 100% zoom and a custom level of zoom you may 

have picked previously. 

Selecting Data 

You can select any or all adjacent fields/columns/records in a table at once. To select an 

entire table of data, open a table in Datasheet view and press Ctrl + A on your keyboard. 

Or, click the Table Selector button (located in the upper left-hand corner or Datasheet 

view) to perform the same action: 

 

 
 



   

 

 

www.MicrosoftTraining.net  0207 987 3777 113 
 

To select two or more adjacent records, click the box to the immediate left of a record 

to highlight it:  

 

 
 

Press and hold the Shift key on your keyboard and click the box beside another record 

in the table. All records in between will be selected, including the record you clicked: 

 

 
 

To select two or more adjacent columns, move your mouse over a column header. Your 

cursor will become a small down arrow; click and hold the left mouse button and drag 

left or right to highlight as many columns as you want: 
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Finally, you can also select any range of adjacent cells inside a column of data. For 

example, if we want to highlight all the fields from the Product ID of Northwind Traders 

Chai to the Standard Cost of Northwind Traders Beer:  

 

 
 

First, click inside the field for the Chai Product Code, as shown above. Move your mouse 

to the bottom or right border of the highlighted field; your mouse cursor will turn into a 

thick cross. Then, click and drag from the highlighted field to the last field you want to 

select: 
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Cutting, Copying, and Pasting 

Once you have selected the data you want, you can easily copy data for use elsewhere 

and paste data into the table. To copy highlighted data from a table, right-click the data 

you have selected and click Copy: 

 

 
 

This saves a copy of the highlighted data in the clipboard of your PC. Once data has 

been copied, it can be used in a word processor, a spreadsheet, or some other program 

that uses text and numerical data. To paste the data in the clipboard to another 

program, you can click Edit  Paste or Data  Paste using the menu of the other 

program. Most programs also feature some sort of right-click functionality; right-click 

your mouse where you want to the data to go and click Paste.  

 

To paste data into a table is a bit more complicated. You will need to make sure that 

your source data does not have the same primary key as any record currently in your 

table. If you do, Access will prompt you with an error saying that a duplicate primary key 

has been detected in the table. You must assign a new primary key to the pasted 

record(s) in order to continue. To perform the paste operation, copy the data from the 

source program and paste it into the Datasheet view of a table by right-clicking inside 

the upper-leftmost cell you want to place the data Paste. 

 

Cutting data in Access requires care if the table you are cutting the data from is related 

to many other tables in the database. Cutting data from a table has the same effect as 

deleting data; that is, it no longer exists in the source table. Therefore, if there are other 

tables in the database that rely on the information you are potentially removing, you will 

need to remove the relationship between the two tables first. Cutting data has the same 

sort of effect as copying data; it is stored on the clipboard of your PC until you paste it 

into another program.  
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Using the Format Painter 

The Format Painter is used to remember the formatting style of one control and ‘paint’ 

each subsequent control so all of them look the same. This tool is very useful if you are 

doing some renovating to the look and feel of a database or if you need to apply a lot 

of changes quickly. The use of the Format Painter is best shown by example. 

 
 

The diagram above shows the Employee Details form found in the Northwind sample 

database.  Next, enter Design view by using the View command. This will show you 

where each command lies in the form: 
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Click any object in the form, like the text box label shown in the diagram above. The 

current formatting for the label appears in the Font section of the Design contextual 

ribbon: 

 

 

 

The small paint brush icon ( ) located in the Font section is the Format Painter. To see 

it in action, let’s first change the look and feel of some labels. First, select the label that 

contains formatting that you want to use: 

 

 

 

Double-click the Format Painter. Now every control you click on will have that 

formatting applied to it: 
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To stop using the Format Painter, click the Format Painter icon once more to turn it off. 

 

The Format Painter is most commonly used in this manner in order to format the look of 

many controls at once. However, if you want to make only once command look like 

another, click the command you want to copy, and then click the Format Painter icon. 

After you use the Format Painter, it becomes deselected. 

Using Undo and Redo 

Undo and Redo are used as a way to recover or reinstate changes you have made to an 

object or file. Like Cut, Copy, and Paste, you can perform the Undo and Redo command 

in many different situations using Access (and many other programs). And like Cut, 

Copy, and Paste, Undo and Redo have their own keyboard shortcuts. (Ctrl + Z and Ctrl + 

Y respectively) 

 

The Undo command is a standard control in the Quick Access toolbar: 
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The Redo command is used by pressing Ctrl + Y or by adding the control to the Quick 

Access toolbar:  

 

 
If you accidentally changed the font used in a control, use the Undo command to erase 

the changes and use the old font again. Access gives you the option to ‘step back’ 

through the last twenty operations you performed.  

To see the operations that were performed before, click the small pull-down arrow 

beside the Undo or Redo command: 
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Pick the option in the list you want to Undo; Access will revert the actions in the reverse 

order in which they were performed. 

 

The only exception to the Undo and Redo command is one that involves the deletion of 

data. If you are not 100% sure that a certain piece of data can safely be removed, you 

should back up the database first. Should records be deleted because of an Undo or 

Redo command, their deletion cannot be reversed. 

Checking your Spelling 

 

In the case of a database, you probably won’t have too many spelling errors as most of 

the data is going to be in abbreviated form, in number form, or proper names that won’t 

be in a dictionary. Nonetheless, Access lets you take advantage of a spell checker to 

check the records of a table for misspelled words. For example, if you misspelled the 

word Street: 

 

 
 

Access’ Check Spelling command will find and report an error like the one above if you 

activate the command in the Records section of the Home ribbon: 
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The Spelling dialogue box will appear with the word it couldn’t find in the Not in 

Dictionary field. The dialogue box has several features to make spell checking easy. It 

offers possible spelling matches in the Suggestions list. You can also specify which 

language you would like the spell checker to use in the Dictionary Language combo 

box. (Be warned that changing dictionary languages may require the Office 2007 install 

media or a connection to the Internet to download a language package.) 

 

The buttons on the right-hand side of the dialogue allow you to: 

 

Ignore Skip over this instance of the misspelled word. 

Ignore All Skip over all instances of this misspelled word. 

Change Change this misspelled word to the highlighted suggestion 

in the Suggestions box. 

Change All Change all instances of this misspelled word to the 

highlighted suggestion in the Suggestions box. 

Add Add this ‘misspelled’ word to the dictionary so any further 

instances will be considered correct. 

AutoCorrect AutoCorrect is a special function of the Microsoft Office 

Package that is designed to always change a misspelled 

word to the first suggestion. For example, if you had to type 

‘Street’ many times for different addresses but you always 

forget to add the extra ‘e,’ Access will automatically correct 

every instance of ‘Stret’ to ‘Street’. 
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Section 3: Review Questions 

 

 

1. A primary key is… 

A. The same in every table 

B. Can only be the AutoNumber data type 

C. A unique identifier for every record 

D. None of the above 

 

2. Databases created from a template can be stored… 

A. Wherever you like, so long as there is room for the file 

B. Only in the hard drive of your computer 

C. On a SharePoint Server 

D. In My Documents only 

 

3. Which of the following is a valid database object? 

A. Module 

B. Form 

C. Query 

D. All of the above 

 

4. If you want to delete a table in Access, you must first… 

A. Delete the primary key, if applicable 

B. Close it 

C. Make a backup copy 

D. None of the above 

 

5. The Search Bar, when enabled, is shown… 

A. In a ‘free floating’ window 

B. In the Home ribbon 

C. In the title bar 

D. In the Navigation Pane 

 

6. Which method creates a new record? 

A. Pressing Tab when you have reached the end of the current record 

B. Use the ( ) command 

C. Use the ( ) command 

D. All of the above 
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7. In order to select multiple records for deletion, press and hold the _______ key. 

A. Windows 

B. Shift 

C. Alt 

D. Ctrl 

8. What is the proper name for this view icon?  

A. Create View 

B. Datasheet View 

C. Design View 

D. Construct View 

 

9. Which command lets you change the dimensions of a field in Datasheet view? 

A. Row Height 

B. Column Width 

C. Field Size 

D. Both A and B 

 

10. If you format a text box label and double-click the Format Painter, you can now: 

A. Format any control to look the same 

B. Format one control to look the same 

C. Format only other text box labels 

D. None of the above 
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SECTION 4: Doing More with your Database 

 
In this section you will learn how to: 

 Create forms 

 Create queries 

 Create reports 

 Use Design view and Layout view to modify a form and report 

 Use the View menu and view icons 

 Manage your Access working space 

 Use different types of filters to sort through your data 

 Use the Print Preview ribbon 

 View your data in different ways before printing 

 Decide if you should print or export a document 
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Lesson 4.1: Creating Forms 

So far in this manual we have learned a lot. You should now know how to enter data 

into a table, create different types of database objects, use templates, and get the tables 

of data to look the way you want. In this section we will learn more about the other 

major types of database objects like forms, reports, and queries. 

What is a Form? 

Simply put, a form is an easy way to input data into a database. It contains fields that let 

you type the information for each field in, it can have an input mask which will make the 

field look like an empty phone number field, and it can contain required field that you 

must enter in order for the database entry to be valid. 

 

We have seen a few examples of forms along the way, such as those featured in the 

Northwind sample database template included with Access: 

 

 
 

Forms can also include functionality not directly related to a table. For example, the 

Login window that appears when you open the Northwind sample database is actually a 

special type of form. 
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Bound vs. Unbound Controls 

We can define a ‘control’ (in the context of a form) as some object contained in the 

form. For example, consider the Login window: 

 

 
 

This form contains two controls: a combo box which allows you to select a name from 

the employees who work for Northwind, and a Login button that will confirm the 

employee selection and open the Home page of the Northwind database (which is 

actually another form). 

 

When creating a form, you will use at least one control, otherwise your form is not very 

useful! All controls in Access, no matter how they are used, fall into two categories, 

bound and unbound. 
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A bound control is one that is directly related to some aspect of a database object. 

Consider the following Product Detail form:  

 

 
 

Every field listed here contains a text box where you can type in some data. The field is 

directly linked to the Products table in the database. So, when you have completed 

entering data for a record and make a new one, all of the data you entered in each field 

in the form gets entered to its respective field in the table. 

 

An unbound control is one not directly related to a database object but still serves some 

useful purpose. For example, the Login button in the Login window is a control that 

performs an action but has nothing to do with any data in the database. Another 

example would be a print button; it might be set up to call a query and construct a 

report, but has nothing to do with the actual data. 
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Creating a Form with the Wizard 

Access features a wizard that allows you to specify how you would like a form to look 

and what table it should be based upon. Access then does the hard work for you and 

creates a usable form in only a few clicks. To create a form using the Wizard, click the 

Create command tab and then click the More Forms command:  

 

 
 

Form Wizard is the first option; click it to start the Wizard. The first page allows you to 

select which table or query Access should link to the form: 
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You can also specify which field or fields you want to use in the form. Click > to move 

the currently highlighted field from the Available Fields list to the Selected Fields list. 

Click >> to move all fields from one list to the other. Click Next to proceed. 

 

The next step of the Wizard lets you choose the layout for your form. Select one of the 

layouts by clicking the appropriate radio button and then click Next: 
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The next page allows you to style your form to make it catch the attention of the user. 

Click one of the styles from the list of those available; you will see a preview of each on 

the left side of the window: 

 

 
 

Select a style you like and click Next. The final page of the Wizard lets you name the 

form: 
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By default, when you click Finish, the form will open so you can start using it right away. 

The second radio button option allows you to open the form in Design view where you 

can modify every aspect of a form. (We will discuss the basics of Design view in the next 

section of this lesson.) 

 

If you leave the first radio button selected, clicking Finish will open the form right away: 
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That’s all there is to using the Form Wizard! 
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Using Design View to Modify Your Form 

You may recall Design view from one of the Step-By-Step exercises in this manual. 

Design view allows you complete control over how a form should look. To enter Design 

view after using a Wizard to create a form, make sure you highlight the “Modify the 

form’s design” radio button in the final step of the wizard:  

 

 
 

If you want to modify the design of an existing form, double-click the form object in the 

Navigation Pane and then select Design View from the View command in the Home 

ribbon: 
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Let’s take a look at what’s going on in form Design view: 

 

 
 

At the top of the window you will see three new contextual tabs appear: Form Tools - 

Design,  Arrange and Format. In the center of the window is the current working space 

(called a canvas).  
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Click on Add Existing Fields and on the right-hand side you will see a pane that lists the 

fields that are available for use in Design view:  

 

 
 

The “Fields available for this view” section shows you all fields associated with the 

table(s) from which the form was directly constructed. 

 

Though much of the use of Design view is beyond the scope of this manual, let’s take a 

look at the different groups of commands you can use to work on a form.  
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The following chart lists the overlying functionality of the Design Ribbon:  

 

Form 

Views 

 

 

Click this 

command to 

cycle or choose 

a view of the 

form. 

Font 

 

 

This section 

allows you to 

modify the look 

and feel of the 

currently 

selected font. 

Controls 

 
 

This section 

allows you to 

add a wide 

variety of bound 

and unbound 

controls to a 

form. 

Tools 

 

 

This section 

provides more 

of the 

background 

functionality 

associated with 

form design 

including the 

ability to modify 

properties and 

change the tab 

order during 

form navigation. 
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Another contextual tab that appears is the Arrange tab :  

 

Control 

Layout 

  

This section of the 

Arrange ribbon allows 

you to add and format 

gridlines.   

Use Stacked and 

Tabular to rearrange the 

form layout.  Remove 

Layout allows fields to 

be moved 

independently. There 

are also options to 

select columns and 

rows.  

Sizing & 

Ordering 

 

 

If you have difficulty 

aligning controls by 

hand or want to align 

controls quickly yet 

neatly, use the 

commands in the Size 

section of the Layout 

ribbon  

Ordering gives the 

flexibility to arrange the 

order and position of 

different controls in 

your form. 

Control 

Layout 

  

This section of the 

Arrange ribbon allows 

you to add and format 

gridlines.   

Use Stacked and 

Tabular to rearrange the 

form layout.  Remove 

Layout allows fields to 

be moved 
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independently. There 

are also options to 

select columns and 

rows.  

Sizing & 

Ordering 

 

 

If you have difficulty 

aligning controls by 

hand or want to align 

controls quickly yet 

neatly, use the 

commands in the Size 

section of the Layout 

ribbon  

Ordering gives the 

flexibility to arrange the 

order and position of 

different controls in 

your form. 

Sizing & 

Ordering 

 

 

If you have difficulty 

aligning controls by 

hand or want to align 

controls quickly yet 

neatly, use the 

commands in the Size 

section of the Layout 

ribbon  

Ordering gives the 

flexibility to arrange the 

order and position of 

different controls in 

your form. 

 

The Format contextual tab has further options: 

 



   

 

 

www.MicrosoftTraining.net  0207 987 3777 139 
 

Selection 

 

 

 The selection navigator 

allows you to select a 

specific control while 

Select All selects every 

control on the form.  

Font and 

Number 

 

As well as changing 

fonts and colors, 

numbers can be 

formatted here rather 

than via the Properties 

panel. 

Background 

 

This section allows an 

image to be added to 

the form background. 

Alternate Row Color 

controls the banding 

color of a tabular form. 

Control 

Formatting 

 

The fill Selected control 

can be formatted   

 

 

Using Forms 

To make use of a form, first double-click its name in the Navigation Pane to open it. 

Then it is simply a matter of clicking the new command in the Home ribbon ( ) and 

entering data into the fields:  
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Any fields that reference an AutoNumber field (such as a primary key) will advance to a 

new value. At the bottom of the form you may recognize the navigation buttons:  

 

 
 

  First Moves to the first record in the table. 

  Previous Moves to the previous record. 

  Next Moves to the next record. 

  Last Moves to the last record in the table. 

  New Creates a new record at the end of the 

table. 
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Lesson 4.2: Creating Queries 

We now have come far enough to get to the real functionality of a database: using a 

query. Having large amounts of data is fine, and having nice looking and well-designed 

forms is great, but if you can’t pose a question to the database and find a result, there is 

not much use for a large list of data. In this lesson we will learn about queries and how 

they work. 

What is a Query? 

A query is a question that is asked of a database control program about the data it 

contains. We specify what particular fields we are interested in finding out, tell the 

database where to look for those fields, and specify any conditions under which to 

search. 

 

Queries are primarily built from tables, but Access gives you the ability to construct a 

query based on the results of another query. Such ‘nested queries’ may require more 

computer memory and resources in order to execute but if constructed with care, can 

save a lot of time, especially when dealing with very large databases. For the purposes 

of this manual, we will keep things simple and stick to small and simple queries. Plus, the 

great thing about queries is that they are only questions asked about data that is 

already there. If you get query results that are completely off the mark, no problem! The 

data is untouched, so provided there is no design flaw in your database, only the query 

needs to be adjusted. 
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Creating a Query with the Wizard 

To create a query using the Wizard, click the Query Wizard command in the Create 

ribbon:  

 

 
 

The Wizard launches, allowing you to select which type of query to build: 

 

 
 

For the purposes of this manual, we will demonstrate a simply query that will retrieve 

the product ID, product name, and price of every product in the Northwind sample 

database. This type of query is defined as a select query, one that is used solely to 

retrieve information. 

 

The next step of the Wizard is selecting which fields you want to use in your query. This 

step of the Wizard should look familiar: it’s just like selecting fields to use in a form.  
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In the Tables/Queries combo box, select Table: Products. Highlight ID and click > to 

move the field to the Selected Fields list. Repeat for Product Name and Standard Cost: 
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The next page of the Wizard gives you the option to apply a few summary calculations 

to the field like the maximum value, minimum value, and the average. However, we want 

to see all products, so leave the Detail radio button selected: 

 

 
 

The final page of the Wizard lets you name the query. A long and meaningful name is 

recommended. Just like in the creation of a form, you have the option to open the query 

right away or modify the design in Design view: 
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Click Finish to view the results of the query: 

 

 
 

As you can see by the diagram, the query results are shown in what is essentially 

Datasheet view. The result of a query is essentially a table complete with its own rows. 

Though more advanced query functionality is beyond the scope of this manual, you can 

actually use the results of a query to construct a table.  
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Using Design View to Modify a Query 

As you gain more proficiency with Access, you will reach a point where using just the 

Query Wizard will not be sufficient to get the results you are looking for. Therefore, you 

can use query Design view to modify any attribute of a query you like.  

 

To access Design view after using a wizard, select the “Modify the query” design radio 

button: 
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If you wish to modify a query that already exists, double-click the query object in the 

Navigation Pane to open it in Datasheet view. Then use the View menu to select query 

Design view:  

 

 
 

Either way, you will be shown the following view: 

 

 
 

The table or tables that were used in the query are present at the top of the window, 

while the various attributes that were specified during the design of a query are listed at 

the bottom. Note that the primary key is shown in the table as a small key icon. You will 

also see six different row listings at the bottom of the window. 

 

The Field row will let you will see all of the fields that are available for use in the query 

(in this case the attributes of the Products table). The second row down is the Table row, 
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where you can specify which table you want to use fields from. The Sort row lets you 

sort the results of the query in ascending or descending order (or no order at all, but 

rather the order in which the query happened to find data first).  

 

The Show checkbox will determine if the field will actually be shown in the query results. 

(If an item is present in a query but does not have the Show checkbox marked off, it will 

still be considered in the query but the data that was used to satisfy the query will not 

be shown.) The Criteria row lets you enter a logical operator and a condition that any 

displayed data must satisfy. 

 

We have seen the results of finding all products in the Products table. If we want to 

show only the items that are more than $50 to purchase, we can enter the criteria ‘> 50.’ 

This expression contains a logical operator (greater than). Other operators include less 

than (<), equal to (=), and not (!). 

 

Query Design view also contains its own contextual tab. Though much of the 

functionality is beyond the scope of this manual, let’s take a quick look at what each 

section of commands does:  

 

Results 

 

 

The Results section of the 

query Design ribbon lets 

you switch between 

views using the View 

menu and execute the 

query. 

Query Type 

 

 

This section of the ribbon 

allows you to modify 

properties of the query 

itself. Use these 

commands to make 

action queries that will 

perform some operation 

on the data in your 

database. 
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Query 

Setup 

 
 

Use these commands to 

modify attributes of a 

query as well as construct 

more elaborate search 

criteria. 

Show/Hide 

 

 

The Show/Hide 

commands are used to 

view and modify different 

background attributes 

about the query and the 

data it will display. 

Using Queries 

 

To execute a query, you simply have to double-click the query name in the Navigation 

Pane. The results will be displayed in a new tab in Datasheet view. Since a query is not a 

bound object, you can delete a query without fear of deleting any data in your tables. 

But be careful if you do delete a query, because there might be another query, form, or 

report that uses the query to retrieve data for display to a user. If you eliminate the 

source query, the dependent object will not function properly.  
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Lesson 4.3: Reports 

Now that we have a little more understanding about how queries work, it would be 

handy to be able to display the data that was retrieved in a clean and easy to read way. 

Access makes use of reports as a way of displaying query results in a printable and 

presentable way. 

What is a Report? 

A report is a formal way of displaying data that has been retrieved from a query. 

Reports, like forms, are completely customizable and easy to create by using a Wizard. If 

the Wizard is not specific enough, you can change the color, layout, style, and more, to 

suit your tastes.  

 

If the data in your database has changed, you don’t need to design a whole new report. 

Simply reissue the report and when Access runs the background query again, the data 

changes will be taken into account automatically. 

Creating a Report with the Wizard 

Many of the reports you create will simply be an exercise in displaying the data in a 

certain way. Since reports are made from queries, and most of the queries will have 

already been built, creating reports using the Wizard is easy.  

 

The Report Wizard command can be found in the Create ribbon: 
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The first page of the Report Wizard should be pretty familiar to you by now; it was used 

to create a form and a query: 

 

 
 

For this example, we will make a report based on the full results from the Customers 

Extended query. The next screen of the Report Wizard allows you to apply levels of 

grouping to the report: 
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Grouping levels are useful in certain queries to help categorize the data returned from a 

query. For example, if you ran a query to list all the different times that a product was 

ordered, you could group based on the product. Each date the product was sold would 

then be categorized under each product name. For the purpose of this example, no 

grouping will be used. The next page of the Wizard lets you organize fields in the report 

in ascending or descending order:  
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Select a field from the combo box. If you want to sort based on descending order, click 

the Ascending button to change the nature of the sort order.  
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The Wizard then asks how you want to organize the items in your report: 

 

 
 

Click the different layout radio buttons to see a preview of how each field will look in the 

report. The checkbox at the bottom of the window will help to squeeze all of the data 

into the same page. This may not always be the best course of action if some fields 

contain large entries. Should the Wizard not produce the results you want, you can 

always delete the report and start again or use Design view to modify the layout. 
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At the next screen, you can choose a style for your report to make it more appealing if 

you are going to print it: 

 

 
 

Finally, the last screen allows you to give the report a name and either view it right away 

or modify its properties in Design view: 
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Click Finish to view the report: 

 

 

Using Design View to Modify a Report 

Like forms and queries, you can enter report Design view by either clicking the “Modify 

the report’s design” radio button before closing the wizard or using the View menu after 

opening a report.  
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Report Design view lets you drag and drop the various fields from the Field List pane. 

Reports use headers and footers like the Design view of a form. Reports also have three 

of their own contextual tabs: 

 
 

The Design, Arrange and Format tabs contain the same commands as the Design view 

of forms. In addition to listing only query results, you can add interactivity to the report 

to do things like show charts and calculate data values from user input. 

 

Design view for reports also features a Page Setup ribbon to customize how the report 

will look on a printed page: 
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The Page Setup option opens a dialogue that can be used to precisely modify page 

settings: 

 

 
 

 

Using Reports 

To view a report, simply double-click its object name in the Navigation Pane. The report 

will open in the main part of the Access window:  
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This Report View will let you scroll through all the details of the report. We will discuss 

how to print and further view a report later in this manual. 
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Lesson 4.4: Sorting and Filtering Data 

The databases we have been dealing with so far haven’t been very large. Most of the 

information available we could scroll through in a few minutes. But if you are managing 

a library or government database, you might spend your entire day looking through just 

one table and still not make it through.  

 

Filters are like small specialized queries that are performed on a single table of 

information. Fortunately, Access has the ability to sort and filter data in order to narrow 

down the results you need. In this lesson we will explore how to sort and filter data in 

your database. 

Using Find and Replace 

If you are familiar with word processing and spreadsheet programs, you are probably 

familiar with find and replace commands. Even Internet browsers feature a find 

command. These commands are designed to search a document of any size quickly to 

find instances of a certain keyword or value and, if applicable, modify it. 

 

You can use the find and replace commands on every database object except reports 

(which are really just documents to be printed), macros (a collection of commands, no 

actual data), and modules (another sequence of commands, again no actual data). You 

can find both commands on the Home ribbon. 

 

The Find command will search through an object and locate all instances of a keyword. 

The Find command also gives you the ability to search only specific columns of data and 

flexibility in how it searches. If you only know part of a word or phrase, you can search 

based on what you know. 
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Find What The Find What field lets you type in a certain word, part of a word, 

or a number. The keywords of any previous searches you have 

performed will appear if you click the pull-down arrow.  

Look In The Look In field lets you search just the primary key of the table or 

the entire current database object.  

Match If you are not 100% sure what you are looking for but at least have 

an idea, you can use different options in the Match field.  

Search The Search field lets you conduct your search up, down, or all over 

the current object. For example, if you are looking for a particular 

name that starts with ‘T’ in a very large database, you can save a lot 

of search time by searching at the fields that start with T instead of 

the whole alphabet. 

Match Case If you are looking for a certain organization name or something that 

is in all uppercase letter, you can have Access ignore all lower case 

entries in its search which can increate the speed of searching. 
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Search Fields as 
Formatted 

Imagine you want to search for a record containing a particular date, 

and you type April 25, 2004. If this box is checked, Access will search 

for all formats of this date, like 04/25/2004, 04/25/04, 25/04/04, 

2004/25/04 and so on. Searching with this box checked will slow 

down certain searches, but is more likely to find the data you need. 

 

The Replace command is an extension of the Find command. It includes all the 

functionality of Find but lets you modify all matches it finds to something else: 

 

 
 

Enter the new word or phrase you want to replace in the Replace With field of the 

dialogue box. The Replace button on the right-hand side of the window will find the 

next instance that matches the search criteria and replace it with the new word or 

phrase. The Replace All command automatically scans the entire object listed in the 

Look In combo box and replaces every match with the new word or phrase. 
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Be cautious; if you perform the Replace All command, you cannot undo the operation. 

You will have to do another Find and Replace to change the fields back. 

Sort Ascending or Descending 

When viewing a table or query results in Datasheet view, you might want to sort 

through the records by hand if you know what you are looking for. Access has a very 

quick way to sort through data listed in columns. Consider the Employees table: 

 

 
 

The Sort Ascending and Descending commands can also be found in the Sort & Filter 

section of the Home ribbon. To sort in this way, click the column header (or headers) of 

the column(s) you wish to sort and then click either the Sort Ascending or Descending 

buttons: 

 

 
 

The records in the table will sort themselves accordingly: 
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Toggling Filter 

To apply different filters, click the column header of any column in Datasheet view. Then 

click the Filter command in the Sort & Filter section of the Home ribbon: 

 

 
 

A pop-up window will appear underneath the selected column header: 
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As you can see in the diagram, the Sort Ascending and Descending commands are 

visible in this menu. Access also provides you with the ability to sort and show records 

based on the values in a column of data. 

 

For example, if you wanted to show only the Sales Representatives, click the Job Title 

column header to select the column and then click the Filter command. Uncheck all of 

the values listed in the pop-up menu except for Sales Representative. 

 

 

 
 

Then, click OK to toggle the filter. Only the Sales Representatives will be shown in the 

table: 
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Using Selection Sort 

Access makes it easy to sort a table of data quickly based on one criterion. For example, 

consider the Standard Cost column in the Products table of the Northwind sample 

database:  

 

 
 

Click the first price in the list to highlight that particular field and then click the Selection 

command ( ) in the Sort & Filter section of the Home ribbon. A small pop-up 

menu will appear: 

 

 
 

Click any of the options to sort the table of data based upon the criteria in the menu. 

For example, if you click Less Than or Equal to $13.50, the table will sort and show the 

less expensive products: 
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The Between option in the Selection command displays the Between Numbers dialogue 

box. Enter the criteria for your search (between 5 and 10 for example) and click OK. 

 

 
 

 

Using Advanced Sort 

Access offers a few other advanced filtering options that are accessible by clicking the 

Advanced command in the Home ribbon: 

 

 
 

Filter by Form The Filter by Form command in Access is sort of like a small query. 

You can specify criteria that will be used to filter the data like a 

query, but its use is more limited. Using Filter by Form is fast and 

easy if you have only a single value you are looking for.  
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For example, if you have a product ID but not a product name, Filter 

by Form can help. Open the Products table in Datasheet view and 

select Filter By Form. Datasheet view will change to the following 

view: 

 

 
 

Each column you click inside will show a combo box. Select one of 

the values in the combo box to add it to the Filter by Form 

operation: 

 

 
 

When you have chosen the criteria you wish to filter, click the 

Toggle Filter command in the ribbon. 

 

 
 

The corresponding record(s) will be displayed: 

 

 

Advanced 
Filter/Sort 

Access uses filters like small queries. Clicking the Advanced 

Filter/Sort command will open a view very similar to query Design 

view: 
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Click and drag fields from the Products list to the lower half of the 

window. You can apply sort criteria (Ascending, Descending) and 

enter search criteria such as a direct expression like the diagram 

above. You can also add any sort of criteria you like including logical 

expressions like greater than (>) and less than (<). Once you have 

entered the criteria, click Toggle Filter to show the results. 

 

 

Clear all Filters This command will remove any filters currently applied to a 

particular object. 

Load from Query This command lets you load a filter from a query already stored in 

your database. Loading from a query is beyond the scope of this 

manual. 
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Save as Query This command lets you save certain types of filters you perform as a 

query to use later on. Saving queries is beyond the scope of this 

manual. 

Delete Tab As you develop more filters for a particular table, you can use each 

one individually, like with an advanced sort for example: 

 

 
 

Use the Delete tab command to remove the filters you no longer 

use. 

Clear Grid If you are performing a Filter by Form operation, use the Clear Grid 

command to reset all of the data columns back to their original 

empty state. If a particular Filter by Form operation is not giving you 

the results you wanted or expected, use this command to reset the 

form. 
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Lesson 4.5: Viewing Data 

We have used Access so far in a simple way, usually opening only one or two objects at 

a time. In this lesson we will learn a bit more about the different views available in 

Access as well as some other viewing management options. 

Using the View Menu 

We have made use of the View menu throughout this manual. The View menu is located 

in a few different ribbons throughout Access and is different for each object you open. 

 

Table 

 
 

 Datasheet view displays all data in a table in a 

columnar view.  

 Design view lets you modify the properties of a table 

to make it contain and display the data you need. 

Form 

 
 

 Form view lets you view the form in such a way that 

you can enter data one record at a time into a table.  

 Datasheet view is a way of showing you the table that 

the form references.  

 Design view lets you modify the look and feel of a 

form as well as add different controls to perform 

actions. 

Report 
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 Print Preview displays the contents of the report in a 

manner suitable for printing or presenting. 

 Report view is an intermediate step between Report 

view and Design view. It lets you adjust the location of 

objects in a report while still being able to see the 

data it contains. 

 Design view lets you modify the look and feel of a 

report as well as add different controls to display data 

or perform actions. 

Query 

 
 

 Datasheet view displays the results of a query in a 

view similar to a table. 

 SQL (Structured Query Language) view is a way of 

viewing and modifying the background ‘code’ used to 

make a query. SQL editing is beyond the scope of this 

manual. 

 Design view lets you add and remove fields from the 

search as well as add criteria to retrieve more specific 

results. 

Using the View Icons 

The View menu has a cousin present in the very bottom right-hand corner of the Access 

window. For example, viewing a table in Datasheet view will show the following buttons:  

 

 
 

These icons are exactly the same as the corresponding items in the View command. The 

view currently in use is highlighted. Hover your mouse over an icon to see its 

description: 
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Click any of the icons to switch to that view. 

 

Using the Tabs 

In previous versions of Access, opening a new database object meant opening a new 

window. After only a few objects, your screen would be pretty full and finding objects 

‘hidden’ under different windows was frustrating. Access eliminates that clutter. Each 

database object you open opens a new tab:  

 

 
 

Simply click a tab to view that object.  
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If you happen to have many objects open at once, arrows will appear on either side of 

the list of tabs allowing you to scroll back and forth through the opened objects: 

 

 

Closing Individual Tabs 

To close a database object, highlight its name in the list of tabs and then click the close 

button underneath the ribbon:  
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Lesson 4.6: Printing a Database Object 

Access lets you print every database object except macros and modules. To print 

properly in Access, you need to have a printer installed on your computer or have access 

to a printer on your business network. 

Using the Quick Print Icon 

The Quick Print icon ( ) is a direct shortcut to print an entire object. The icon itself is 

located in the Quick Access toolbar.  

 

 
 

Clicking the icon will directly print the currently displayed database icon to the default 

printer installed on your machine. 

Using the Print Menu 

The Print icon located in the Quick Access toolbar is great for printing objects that are 

prepared and ready to go. However, in most cases you may only want to print a small 

amount of data.  

 

The Print command in the File menu has two functions. If you click the Print command 

directly, you will see the Print dialogue box appear. Use this to specify which pages to 

print as well as how many copies. Then, click OK to print the document: 
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The File, Print option lets you open the Print dialogue (Print), directly print the entire 

document (Quick Print), or see what the printed document will look like (Print Preview): 

 

 

Using Print Preview 

Print Preview is used to view a document in full form before actually printing it. To open 

this view, click the Office Menu, point to the right-facing arrow by the Print command, 

and then click Print Preview: 
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The Print Preview ribbon will give you the option to modify how the finished product 

will look. Use the Zoom Bar in the lower right-hand corner of the window to zoom in or 

out of the current document. 

 

The Print command on the far left-hand side of the ribbon will open the Print dialogue 

box. If you have finished printing or are not ready to print yet, click Close Print Preview 

on the far right-hand side.  

 

Using the Print Preview Ribbon 

Let’s explore the functionality of the Print Preview ribbon. 

 

The first command, Print, opens the Print dialogue box. 

 

 
 

The Page Layout section lets you adjust properties of the page. 

 

 
 

Choose from a number of paper output sizes, choose a page orientation, and choose a 

normal, wide, or thin margin. The Print Data Only command will not print any graphics 

or background colors. The Columns command lets you print pages of your report like 

newspaper columns. The Page Setup button opens the full Page Setup dialogue box 

containing all of the above functionality and more: 
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The Zoom commands let you preview multiple pages at once.  

 

 
 

You can view one, two, four, eight, or twelve pages at a time using the More Pages 

command. 

 

The Data section of the ribbon allows you to save a digital copy of a database object 

instead of printing a paper hard copy.  

 

 
 

You have quick links to export an object to an Excel file, Text File, PDF or XPS file. 
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The More command offers the following: 

 

 
 

When you’re done, click the Close Print Preview button.  

 

 
 

This command will close the current Print Preview window and return to the database 

file. 

 

 

Printing vs. Exporting 

We learned in the last lesson that the Print Preview ribbon provides the functionality to 

export a particular database object to some other digital form instead of printing a hard 

copy. Exporting a database object in Access has its advantages.  

 

Since Access stores data in a table very similarly to the way Microsoft Excel stores data 

in a spreadsheet, exporting to Excel is a good option versus printing a table. For 

example, if you do not have Access on your home PC but do have Excel installed, you 

can export a table as Excel, work on the data at home, and then import the data back 

into Access using the Import command. 

 

A big addition to Access versus previous versions is the ability to publish to a PDF file. 

The PDF format is reasonably compact in file size and easily viewable on nearly every 

computer platform. With the near-indispensable use of USB flash drives, even very large 

data files fit nicely on these small and ultra-portable storage devices. Consider exporting 

a database object as a PDF versus printing a long report and then making photocopies.  

 

If you are planning on using the raw data from Access in another database management 

software package, exporting as a plain text file sure beats printing out every last bit of 
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data and typing it all in by hand again! The standard character set saved as a plain text 

file is readable on virtually every computer platform in one way or another. 

 

If you have need in your organization to produce services over the Internet, XML and 

XPS are common file formats that are quickly gaining a lot of popularity. Consult with 

your IT department or website administrator to see if their job might be made easier if a 

database file or object was exported in XML or XPS form. 
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Section 4: Review Questions 

 

 

1. A bound control is… 

A. One that is directly linked to an external PDF file 

B. One that computes something not directly related to data in a table 

C. One that is linked directly to data in a table 

D. None of the above 

 

2. An unbound control is… 

A. One that is directly linked to an external PDF file 

B. One that computes something not directly related to data in a table 

C. One that is linked directly to data in a table 

D. None of the above 

 

3. Forms, queries, and reports can draw data from how many data sources? 

A. Only one at a time 

B. Two 

C. A maximum of four 

D. As many as you like 

 

4. Which answer best completes the following phrase: "Select queries do not..." 

A. Get used in most databases 

B. Modify the data they query 

C. Reference more than one table 

D. All of the above are true 

 

5. Query results are displayed in a manner very similar to… 

A. Design view 

B. Form view 

C. SQL view 

D. Datasheet view 

 

6. What is the proper name for the following operators when used in Access: <, >, = 

A. Comparison operators 

B. Logical operators 

C. Criteria operators 

D. Query operators 
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7. What does grouping mean in terms of a report? 

A. It is used as a way to organize data in the report 

B. It is used to keep the same data types together in a group 

C. It is used to categorize all the picture attachments in a table 

D. None of the above 

 

8. The ______ command is an extension of the ______ command. 

A. Find, Replace 

B. View, Find 

C. Replace, Find 

D. Replace, View 

9. What does the following command do?  

A. Alerts you of inconsistencies in the database 

B. Runs a form 

C. Deletes a Report 

D. Runs a query 

 

10. The Print Preview ribbon… 

A. Allows you to adjust how a printed page will look 

B. Lets you view up to twelve pages at a time 

C. Contains data exporting commands as well as the Print command 

D. All of the above 
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